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1.0 ABOUT LIEBERT® NFORM™

Liebert Nform is a software tool that monitors the condition of networked equipment, tracks alarms 
and other conditions, then sends notifications and performs other management actions based on those 
conditions. 

The software may be configured to monitor and manage a wide variety of Liebert devices and other 
equipment. The devices may be organized into geographical or functional areas, mapped on 
customized floor plans and displayed graphically in a logical tree format.

Liebert Nform must be installed on a computer that acts as a server; client versions of the software 
may be installed on an unlimited number of workstations for remote monitoring and management.

1.1 How Do You Contact Emerson Network Power for Technical Support?

For help on setting up Liebert Nform or any other monitoring product, contact Emerson’s Software 
Technical Applications Support Center at:

Table 1 Technical support contact information

UNITED STATES 1 800 222 5877

FRANCE +33 (0) 1 46 87 51 52

GERMANY +49 (0) 89 99 19 220

ITALY +39 (0) 2 98250 324

NETHERLANDS +31 (0) 475 503333

UNITED KINGDOM +44 1628403200

EUROPE +800 11554499

ASIA +800 11554499

AUSTRALIA 1 800 147704

NEW ZEALAND 0 800 447415

WORLDWIDE
1 614 841 6755

FAX: 1 740 833 8631

Product
Information

All Liebert Products: http://www.liebert.com

Liebert Nform Product Information: http://nform.liebert.com

Liebert Nform
Technical Support

Liebert Nform Support Website Login: http://applications.liebert.com/nformsa

E-Mail for Technical Support: liebert.monitoring@emerson.com

http://www.liebert.com
http://nform.liebert.com
http://applications.liebert.com/nformsa
mailto:liebert.monitoring@emerson.com
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1.2 What is Liebert Nform?

Liebert Nform uses Simple Network Management Protocol (SNMP) and Emerson Network Power’s 
Emerson Protocol to monitor and manage a wide variety of networked equipment, protecting it from 
costly damage resulting from power failures and mechanical breakdowns. The monitored equipment 
can include industrial air conditioning units, Uninterruptible Power Supply (UPS) units and other 
devices that accommodate an SNMP card to communicate over an Ethernet network. Liebert Nform 
will monitor and manage devices manufactured by Emerson or by other equipment makers.

Liebert Nform constantly monitors configured equipment, warns of problems ranging from power 
quality to environmental conditions. 

This product also permits configurable responses to equipment alarms, including support for audible 
alarms, e-mail and on-screen notification.

1.2.1 How Does Liebert Nform Work?

Liebert Nform on a host computer communicates with managed devices using either SNMP or the 
Emerson Protocol to detect problems ranging from power quality to environmental conditions.

The user has the option of expanding Liebert Nform’s network capabilities with additional licenses. 
Licenses are available in increments of 30, 100 or 500 additional monitored and managed devices. 

Liebert Nform employs the SNMP protocol and static IP addresses to issue notifications and 
warnings, launch scripts and send e-mail messages. It uses HTML to graphically display system 
information for devices with an SNMP card that is Web-enabled. Liebert Nform performs its 
monitoring and management processes using the network—instead of requiring separate, expensive 
hardware and cables that might run alongside network lines.

Typical sequence
• Liebert Nform constantly monitors multiple SNMP devices made by Emerson or other 

manufacturers. 
• In the event any alarm occurs, Liebert Nform receives an SNMP trap.
• According to configuration, Liebert Nform issues a local notification to the monitoring computer, 

executes any associated actions—sending e-mails, writing alarm data in files and launching 
scripts—and logs alarm data. 

• Users can later acknowledge and delete any alarms from Liebert Nform.
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1.2.2 Key Features

Table 2 summarizes important features available in Liebert Nform.

Table 2 Key features of Liebert Nform

Feature Improvement

Dashboard
View

• The system supports a user-customized Dashboard. This view allows users to quickly create a 
full spectrum of charts and graphs that can represent a total system view of all managed 
devices, a specific device and/or a group of managed devices. 

• Large icons display a total count of devices by each state, including a numeric value 
representing the total count of devices in alarm, devices with no communication and devices 
that are normal. 

• Status buttons and filters offer a quick way to select which devices to show in gadgets with 
customized views of devices in a particular state. Status buttons toggle between customized 
device status views and all devices. Filters are easy to apply in any gadget by simply entering 
text to search for in the device definitions, such as IP address or name.

Area/Floorplan 
Views

Customized views may be created to organize devices into groups or add graphic floor plans as 
visual reminders of where devices are located. Device icons with labels and status indicators 
offer a quick way to identify problem devices and their locations.

Detachable 
Windows

The Navigation Portal and Alarm Management Interface Window can be detached from the main 
software application, thus allowing the Liebert Nform Viewer to be run on multiple screens. This 
was specifically designed for deployment in IT Network Operation Centers (NOC).

Parametric Data
Trending

All devices can be configured for trending parametric data. This trend data can be viewed within a 
trend graph and can be exported to a file that can be used to analyze parametric data from a 
system view.

Priority Status 
Polling

Users can define the polling priority for each managed device, allowing for quick response times 
on critical equipment.

Internationalization

The software supports the following languages:

• English
• French
• Italian

• German
• Spanish

• Simplified Chinese
• Japanese

Language settings are stored at each client, allowing users to specify their language of choice.

Users and Groups

By default the system comes with three (3) predefined user groups: Administrator, Power User 
and Operator. Users with Administrator privileges can administer users and groups for the 
complete enterprise.
Users can also create new user groups and define the access level and rights of each group. 

Audit Logging
All user actions and configuration changes are tracked and stored in a server audit log file. This 
gives the administrator the ability to monitor changes that are submitted to the Liebert Nform 
server.

Device Info Links
Devices can be configured for informational links that allow a user to create links directly in the 
software to display online help files and/or user manuals.

Alarm Management

Each device’s alarm events have been predefined in three (3) default severity levels: Critical, 
Warning and Information. These are the Emerson-recommended severity levels defined in the 
software.
The software can be configured to auto-acknowledge alarms by severity level, thus allowing 
intelligent processing of alarm-event data. 

Additional Actions

• Shutdown: configuring graceful shutdown of MultiLink client computers
• Forward trap: sending traps received to a specific computer (hostname or IP address)
• Read data: collecting samples of data points from selected managed devices
• Write data: changing values of selected data points based on specified alarms or events

Import Configuration
Data From Earlier 
Versions

An import utility allows transferring previously configured data that has been exported from an 
earlier version of Liebert Nform (version 2.0 or later) on the same computer or a different 
computer. Data that can be transferred includes licenses as well as configured devices and 
e-mail notifications.

Liebert Rack PDU 
Outlet Grouping

Data from Liebert Rack PDU devices may be viewed at the PDU, branch and receptacle levels 
through the logical groups feature of Liebert Nform. Users may control receptacles individually or 
in groups—for example, turn receptacles on or off.
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1.3 Who Can Benefit From Liebert Nform?

Any industry operating devices utilizing the SNMP protocol can benefit from using Liebert Nform to 
protect valuable equipment, data and other assets in the event of power or mechanical failure. 

Liebert Nform’s protection can be extended beyond equipment manufactured by Liebert to encompass 
other makers’ SNMP devices. Liebert Nform ships with templates—specifications and functionality—
for Liebert-built SNMP devices. Liebert offers templates for other manufacturers’ equipment; contact 
your local Liebert representative, value-added reseller, or distributor for information.

1.4 What is Required to Use Liebert Nform?

Visit the Liebert Web site at http://nform.liebert.com for the latest product information. The Web 
site always has the most detailed and up-to-date information on system requirements and Liebert 
Nform’s capabilities.

1.4.1 Connecting Host Computer and SNMP Devices

SNMP communication allows you to take full advantage of Liebert Nform’s features. The host 
computer connects to an SNMP-enabled device over a network. Information and management 
commands may be passed over the Internet, a Local Area Network (LAN) or a Wide Area Network 
(WAN) via SNMP protocol and static IP addresses.

Liebert Nform works with a network connection and any of these types of cards:

1. SNMP card with Web capability such as the Liebert IntelliSlot® Web Card family

2. SNMP card without Web capability, such as the Liebert IntelliSlot SNMP card

http://nform.liebert.com
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1.4.2 Requirements for Installing Liebert Nform

Before beginning installation, review these requirements:

The prospective user must have:
• 2 GHz dual processor or better

• 2 GB RAM for server; 1GB RAM for Viewer only

• 3 GB free disk space for server; 1 GB free disk space or better for Viewer

• The Liebert Nform software (Visit the Liebert Web site at http://nform.liebert.com or contact 
your local Liebert representative, value-added reseller, or distributor for information.)

• This manual (downloadable from the Liebert Web site)

• A computer with Microsoft® Windows® XP with SP2 (64-bit), Windows XP with SP3 (32-bit), 
Windows Server® 2003 with SP2, Windows Vista® with SP1 or later, Windows Server 2008 with 
SP1 or later, Windows 7 or Windows Server 2008 R2.

• A monitor capable of 1280x1024 or higher screen resolution with a 16 Bit (or better) color setting

• A communications link between the SNMP device and the host computer: local network, Internet 
or Intranet, utilizing SNMP protocol and static IP addresses

• Availability of UDP port 162 for receiving traps

• Availability of UDP port 47808 for read-write access to devices with Emerson Protocol

• Availability of TCP port 3442 for remote viewer connections

• Ability to access the following Web sites for Software Assurance support:

http://applications.liebert.com/nformsa/ 

https://publicservices.liebert.com/nformsa/ 

To test access to each of these sites, click on a link above or paste the URL into your browser.

• The first link will take you to the Liebert Nform Support Login page.

• The second link will display a short message about the Software Assurance web service and 
then take you to the Liebert Nform Support Login page.

• If either link fails, contact your network administrator for assistance to verify network 
connectivity and firewall settings.

• TCP/IP connectivity throughout the network

If you need help registering for Software Assurance, contact Emerson (see Table 1 - Technical 
support contact information).

If upgrading from earlier versions 
(see 2.4 - Upgrading From Older Versions of Liebert Nform):

• Upgrading your configuration is possible for version 2.0 or later.

• For versions prior to 2.5, configuration files must be exported manually using an export utility 
from the Liebert Nform 4 CD or the export feature in version 2.5.002 or later.

• The upgrade from version 2.5 or later automatically imports all configuration files, including 
licenses.

NOTE
Check with your System Administrator about the need to disable certain network or virus 
protection software.

http://nform.liebert.com
http://applications.liebert.com/nformsa
https://publicservices.liebert.com/nformsa/
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1.4.3 Licensing

Liebert Nform may be installed as a full package or as a Liebert Nform remote client. 

• The full package consists of the Nform Service and the Nform Client.
• The Liebert Nform remote client consists only of the Nform Client.

The license delivered with Liebert Nform allows users to configure the software to monitor and 
manage devices from the server and an unlimited number of remote clients. Users have the option of 
expanding Liebert Nform’s network capabilities with additional licenses (see Table 12). The 
delivered license also allows users to configure Liebert Nform to perform data logging and forward 
traps to a network management site. 

Liebert Nform can monitor any part of a network. Its functionality permits it to monitor any 
SNMP-enabled device or any device with Emerson® Protocol that can be contacted via the local 
network or the Internet. These devices include those made by Emerson and by other manufacturers 
(with Device Type Definitions available from Emerson—see 18.5.1 - Tools Menu - Install DTD).

1.5 Sample Liebert Nform Configuration

Example of Liebert Nform on a Network

Figure 1 shows one possible configuration of a Liebert Nform server that is monitoring and 
managing various Liebert and non-Liebert devices. The network also has Liebert Nform client 
software installed on another computer and a network management system. 

When an alarm is received, Liebert Nform can send e-mail notifications, append alarm data to a file 
and run scripts.

Figure 1 Sample Liebert Nform configuration
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2.0 INSTALLING THE SOFTWARE

This section explains how to install Liebert Nform, from the Web from a distribution CD.

2.1 Installation
1. Insert the Liebert Nform CD in the CD drive. The Setup wizard starts automatically.

Note: If the Setup wizard does not open automatically, launch Setup.exe from the CD. One way 
to do this is: Click on the Start button, then Run. In the Run window, click on Browse to 
locate the file Setup.exe on the CD, highlight the file name and click Open. Click OK to 
begin installation.

2. After viewing the Welcome and Readme information, read the Liebert Nform License agreement. 
• If you accept the terms and conditions of the license agreement, click I accept the terms in 

the License Agreement and then click Next.
• If you do not accept the terms and conditions, click I do not accept the terms in the 

License Agreement and then click Cancel to abort the installation.
3. In the Select Setup Type window, shown below, choose the type of installation:

• Nform Full Package
For the application server—choose this for the computer that will be the Nform application 
server on the network or for an installation with a single computer. 
This option will install both server and client software.

• Nform Remote Client
For client workstations—choose this option if the full package is already installed on another 
computer on the network. 
This option will install client software only.

4. Click Next.

NOTE
For details on setting up an SQL Server database for a new Nform installation, see the 
ReadMe file in the SQL folder on the CD (e.g., D:\sql\ReadMe.txt). 

For details on upgrading an SQL Server database from an existing Nform installation, see 
the ReadMe file in the SQL upgrade folder on the CD (e.g., D:\sql\upgrade\ReadMe.txt).
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5. In the Destination Folder window, shown below:
• Emerson recommends using the default location for software installation. (To select a 

different location, click on the Browse button and choose the location.) 
• (If Nform Full Package selected in Step 3) Choose the type of database to be used:

• Bundled Database (default)
• Microsoft SQL Server Database

• To create a program shortcut on the computer desktop, place a check mark  in the Add 
shortcut to the Nform Viewer on the Desktop.

6. Click Next.

7. In the Ready to Install the Application window, review the details and click Next to begin 
installing the software. A dialog box displays a progress bar.

8. A message indicates that installation was successful. Click Finish to exit the Setup wizard.

Upon initial login, the Nform System Startup wizard will be activated to complete the setup process 
(see 2.2 - Registering for Software Assurance and 2.3 - Nform System Startup).

INSTALLATION TYPE
Nform Full Package
selected in Step 3

INSTALLATION TYPE
Nform Remote Client
selected in Step 3

Nform Full Package 
installation only:
Select type of database
to be used

Nform Remote Client 
installation only:
Note the database type 
does NOT appear for 
this type of installation
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2.2 Registering for Software Assurance

Registering for Software Assurance offers added benefits such as around-the-clock technical support 
both on the Liebert Nform support Web site and by phone, as well as access to software updates, 
technical resources and new and updated device definitions for products to be monitored.

The startup process described in 2.3 - Nform System Startup provides a quick way to register. You 
may skip registration during the startup process if you prefer to use the software for a temporary 
evaluation period and register later.

For systems that are not connected to the Internet or are otherwise quarantined, follow these steps 
and proceed to 2.3.4 - Registering Offline (Quarantined) Systems.

2.2.1 Evaluation Installation

Liebert Nform may be installed in a 90-day evaluation installation mode by:

• not entering a product license key,
or

• entering a product license key but without registering for Software Assurance

If no product license key is entered, the evaluation setup permits monitoring up to five devices 
until a base license key is entered or 90 days, whichever comes first. If no product license key is 
entered within 90 days, Liebert Nform’s monitoring capability will reduce to one device. Liebert 
Nform screens will display the word [EVALUATION] in the title bar. If no license key is entered, the 
evaluation setup permits monitoring up to five devices; you will not have access to software updates 
and other resources.

If you entered a product license key but did not register for Software Assurance, you may 
configure as many devices as your license permits and monitor them for 90 days; you will not have 
access to software updates and other resources.

If the Nform system is not registered, you will be prompted about registration in the following ways:

Title Bar
• The title bar displays a reminder in brackets:

• [EVALUATION] if you have not yet entered your Nform license keys or have not registered 
for Software Assurance

• [UNREGISTERED] if you have not yet registered your Nform system or 
• [EXPIRED] if you need to renew your subscription.

Registration status in 
title bar
[EVALUATION]
[UNREGISTERED] or
[EXPIRED]
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Reminder Window
• If the Nform system has never been registered, a Reminder window appears when a user with 

permission to manage licenses logs in to a server.

To register your Liebert Nform software after the startup process described in 2.3 - Nform System 
Startup, perform one of the following (when logged in as a user with permission to manage licenses):

• Click Yes in the Reminder window shown above, then refer to 5.2.1 - Enter Customer 
Information for Nform and Software Assurance for details on the window that opens.

• Click on the Application menu, then Register Product at any time to begin the registration 
process (see 5.2 - Register Product for details).

2.3 Nform System Startup

The Nform System Startup process described in this section allows you to set up administrator access 
to Liebert Nform, enter any license keys purchased with the software and register those license keys 
for Software Assurance. Software Assurance offers added benefits such as software updates and 
technical support. See 2.2 - Registering for Software Assurance for more information.

FOR INITIAL STARTUP ONLY: User Name = “Administrator” (No Password)

A built-in Administrator account with no password is created during installation; this account has 
full access to all features and can add users with varying levels of access. To protect configuration 
settings, all users require a password.

The Nform System Startup wizard opens immediately after the first login to the Nform Viewer while 
the Administrator password is not yet assigned.

Reminder window if Nform 
system is not registered or about 
to expire
(appears after Viewer is opened 
by user with permission to 
manage licenses)
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The startup wizard guides you through these steps:

Emerson recommends completing all these steps immediately after installation to simplify the setup 
process. The only step required at this time, however, is setting an Administrator password. The 
remaining steps may be completed later. To do these steps later, see 5.2 - Register Product.

Start the Wizard

To launch the Nform System Startup wizard:

• Start the Nform Viewer.
• On initial startup, the user name is Administrator and no password is required. The user may 

need to enter the hostname or IP address of the Liebert Nform server on initial startup.
• User name: Administrator (box filled in for initial startup)
• Password: (None required for initial startup)
• Server: localhost (box filled in if the Viewer is started on the Nform server) or 

the hostname or IP address of Nform server where Nform Full Package resides
• The Nform System Startup wizard opens. Proceed to the next section, 2.3.1 - Set Administrator 

Account Password.

Step For details, see:

1. Set a password for the Administrator account (the built-in 
account created during installation).

2.3.1 - Set Administrator Account 
Password

2. Create a separate Nform user account with administrator 
privileges. 2.3.2 - Enter Customer Information for 

Liebert Nform and Software 
Assurance3. Create an account on the Liebert Nform Support Web site 

(with the user account information from Step 2).

4. Enter license keys purchased with your system.
2.3.3 - Enter License Keys and 

Register5. Register your system for Software Assurance using the 
license keys entered in Step 4.
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2.3.1 Set Administrator Account Password

After the Nform System Startup wizard opens:

• At the welcome screen, click Next.
• The Set Administrator Account Password window opens, as shown below.

The Administrator has full access to all features of the software and is generally reserved for use 
in emergencies. 

Emerson® recommends creating at least one separate user account for daily use and for Software 
Assurance registration, as described in the next section, 2.3.2 - Enter Customer Information 
for Liebert Nform and Software Assurance.

• Enter a password in the Password box, then re-enter it in the Confirm Password box.
The password is case-sensitive and must consist of two to 14 characters—with any combination of 
letters, numerals and symbols. Be sure to record the password in a secure place.

• Click Next.

NOTE
A password must be set for the built-in Administrator. For security, it cannot be skipped.
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2.3.2 Enter Customer Information for Liebert Nform and Software Assurance
The Enter Customer Information window allows you to create a second administrative user account, 
in part to act as a backup to the built-in Administrator account in case one of the passwords is lost or 
forgotten. If you register for Software Assurance (SA), the second administrative user account will be 
used to generate a technical support account on the Nform Support Web site.

Create a Separate Administrative User Account
The top portion of the window allows you to create a user account for day-to-day administration of 
Liebert Nform. This step is highly recommended even if you are just evaluating the software and plan 
to register later. This account will be assigned to the Administrators group (see 13.1 - Add 
Individual Users) with full access to all features (same as built-in Administrator). 
To create a new administrative user account, complete these fields:

• User Name: Enter a user name for the new account. This will be used to log on to Liebert Nform.
• Full Name: Enter the person’s name to identify the user.
• E-mail Address: Enter the person’s e-mail address. This will be used to log onto the Nform 

Support Web site.
• Password: Enter a password, then re-enter it in the Confirm Password box. The password is 

case-sensitive and must consist of six to 14 characters—with any combination of letters, numerals 
and symbols. Be sure to record the password in a secure place.

• Phone: Enter the user’s telephone number, including area code. This field is optional.
• To set up additional options for this user account, such as alternate contact information, click the 

Edit button to open the User Properties window (see 13.1 - Add Individual Users).

Create a Related Account for Software Assurance
By default, Use this information for Software Assurance registration is checked to make it 
easy to register your product for Software Assurance. This option creates an account on the Nform 
Support Web site using the information at the top along with the company information at bottom. 
This Web site account will be used to register your product license keys so you may receive the full 
benefits of the Software Assurance program. You may skip this step if you prefer to register later.

• To register, check Use this information for Software Assurance registration and enter the 
following information. NOTE: This information will not be distributed to any outside company.

• Company: Enter your company name.
• Address 1 and Address 2: Enter street address or P.O. box and city.
• Country: Choose the country from the drop-down list.
• Postal code: Enter a postal code as needed for your location.

• To use this or an existing account for another Nform installation, check I already have a Software 
Assurance account. The e-mail and password entered above will be used for the SA account.

• To register later, remove the check mark from the Use this information for Software 
Assurance registration box.

• Click Next. A confirmation window indicates whether a user was created (above right). Click OK.

Confirmation - 
user created
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2.3.3 Enter License Keys and Register

The final step in the startup wizard is to enter any license keys purchased with Liebert Nform.

Emerson recommends entering these keys now to simplify the setup process and proceed with 
registration.

This may be done at a later time; however, the system will operate in evaluation mode until a base 
license key is entered. See 4.4 - Enter the License Key.

If no product license key is entered, Liebert Nform will monitor up to five devices until a base license 
key is entered or 90 days, whichever comes first. If no product license key is entered within 90 days, 
Liebert Nform’s monitoring capability will reduce to one device. Liebert Nform screens will display 
the word [EVALUATION] in the title bar. If no license key is entered, the evaluation setup permits 
monitoring up to five devices; you will not have access to software updates and other resources.

If you entered a product license key but did not register for Software Assurance, you may configure as 
many devices as your license permits and monitor them for 90 days; you will not have access to 
software updates and other resources.

Register
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To install a Liebert Nform license key:

1. In the Licenses window, click the Add button at the top right. (For details on using the Add 
button under MultiLink License, see 4.4.2 - Add a Liebert MultiLink 1.5 Shutdown License.)

2. Read the license agreement, and click I accept to continue.
3. In the Add License window, enter the license key from the sticker on the CD case or the certificate 

provided by Emerson, then click OK. There is no need to enter hyphens (-) in the license key.
4. If you purchased additional licenses, repeat Steps 1 to 3 to install each license.

After installation, the license key numbers appear in the Licenses window or may be viewed 
through the Help menu. See 4.4.3 - View License Key Information.

5. Click the Register button to initiate registering the Nform system. 

6. A confirmation dialog box appears if registration was successful. The following error message 
appears if the licenses could not be registered.

Registration Notifications

If a product license key is entered, but Liebert Nform is not registered, the software will monitor the 
number of devices on the license for 90 days. The software will display reminder prompts about 
registering the software similar to the window below. If not registered within 90 days, Liebert Nform 
will reduce monitoring to one device.

The title bar displays a reminder in brackets:

• [UNREGISTERED] if you have not yet registered your Nform system or
• [EXPIRED] if you need to renew your subscription.
• [EVALUATION]

NOTE
To register the product offline (manually), refer to 2.3.4 - Registering Offline 
(Quarantined) Systems for details on using the Export Registration button to create an 
encrypted file for manual registration.

Registration status 
in title bar
[UNREGISTERED] 
or [EXPIRED]

This window is 
displayed if no 
product license has 
been installed
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2.3.4 Registering Offline (Quarantined) Systems

For systems that are not connected to the Internet or are otherwise quarantined, follow these steps to 
complete the registration process. This involves generating a registration file to take to another 
computer, one that is online, registering at the Liebert Nform site on that computer, then generating 
a file to enter in the Nform installation on the offline computer.

1. Export the registration file.
• After entering the appropriate license keys (2.3.3 - Enter License Keys and Register), 

click the Export Registration button as shown below.

• The following Registration Update window displays a message confirming the creation of a 
product registration request file and its location, along with the URL to complete the process:

• The product registration request file is called Registration.bin and may be found on the 
same machine where the Viewer is running in the export subfolder of the user folder. In this 
example, the full path is C:\Nform\user\export.

• The URL to visit is http://applications.liebert.com/nformsa/.

NOTE
Registration may be delayed for 90 days. During that time, Liebert Nform will display 
reminders to register the software installation.

Export 
Registration

http://applications.liebert.com/nformsa/
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2. Copy product registration request file to an Internet-enabled computer.
• Navigate to the product registration request file called Registration.bin, which may be 

found in the export subfolder in the user folder on the machine where the Viewer is running.

3. Visit the specified Nform SA site (http://applications.liebert.com/nformsa/) on a 
different, Internet-enabled computer.

• Click on Register Product in the My Nform System menu, as shown below.

4. Upload the exported product registration file.
• Click on the Browse button and locate the product registration file Registration.bin, which 

was exported in Step 1.
• Click the REGISTER button. If successful, a link appears to a registration response file.

5. Download the registration response file and copy it to the Nform system.
• Click on the link to download the response file for import into the Nform system.
• Copy that file to the offline computer where Nform is installed.

http://applications.liebert.com/nformsa/
http://applications.liebert.com/nformsa/
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6. Open Liebert Nform on the offline computer system to complete the registration.
• Click on the Application menu, then Register Product.

• Click the Browse button to locate the registration response file, which was downloaded from the 
Nform SA site in Step 5.

• Click Finish.
• The Registration Update window displays a message indicating whether the registration was 

successful.
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2.3.5 Adding Subsequent Licenses

If another license for either Liebert Nform or Liebert MultiLink® is added to a system without an 
internet connection, the steps in 2.3.4 - Registering Offline (Quarantined) Systems must be 
performed for the new license. Liebert Nform will display the reminder below.

Systems that are connected to the Internet will get the new license registered automatically as 
detailed in 2.3.3 - Enter License Keys and Register.

2.4 Upgrading From Older Versions of Liebert Nform

The configuration from earlier versions of Liebert Nform (version 2.0 or later) can be transferred to 
new installations. The upgrade and transfer process requires exporting data from the Liebert Nform 
2.X application.

The export can be done either of two ways:

• Use the export feature from the File menu in the Liebert Nform 2.5.002 or later version (see 
2.4.1 - Use the Export Feature in Liebert Nform 2.X), or 

• Run the export_utility.exe program in the Upgrade folder on the Liebert Nform 4.X CD (see 
2.4.2 - Use the Export Utility from the Liebert Nform 4 CD).

NOTE
After upgrading from an earlier 4.x version of Liebert Nform, users with permission to manage 
licenses (see 13.2 - Assigning Users to Groups) will see the Reminder window described in 
2.2 - Registering for Software Assurance on the first login.
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2.4.1 Use the Export Feature in Liebert Nform 2.X

To use the export feature in Liebert Nform version 2.X:

• Start the Viewer, making sure you have access to the import/export function.
• Click on the Configure tab.
• Click on the File menu, then choose Import/Export.

• Click to place a check mark  next to each type of data you wish to export, or click Select All to 
check all boxes. (Click Clear All to remove all check marks.)
The exported data that will be used for the upgrade includes:

• Liebert Nform license keys
• Liebert MultiLink shutdown licenses
• Managed devices
• Shutdown clients
• E-mail actions

• The tree at right displays the location where the export files will be saved. If desired, select a 
different location.

• Click the Export button to create text files of all selected data.
• Check to make sure the files are successfully exported, then copy all export files to the Export 

folder in the Program Files folder on the Nform 4 server. 



Installing the Software

Liebert® Nform™ 21

2.4.2 Use the Export Utility from the Liebert Nform 4 CD

To run the export_utility.exe program that may be found in the Upgrade folder on the Liebert 
Nform 4 CD:

• Run the program called export_utility.exe, which may be found in the Upgrade folder on the 
Liebert Nform 4 CD. (Double-click on the file or click the Start button, then click Run, enter the 
full path or Browse to locate the file, then click OK.)

• Click on the File menu, then choose Import/Export.

• The Nform Export Utility displays steps executed during the export process, then a confirmation 
window asks whether you wish to open the folder to view the exported files. Click Yes to do so.
The exported data that will be used for the upgrade includes:

• Liebert Nform license keys
• Liebert MultiLink shutdown licenses
• Managed devices
• Shutdown clients
• E-mail actions

• Check to make sure the files are successfully exported, then copy all export files to the Export 
folder in the Program Files folder on the Nform 4 server. 
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2.4.3 Import Exported Data from a Different Server

If Liebert Nform 4 will be installed on a different server, install it, create a temporary folder for the 
export files, then use the Nform Tools application (also see 18.0 - Using Nform Tools): 

• Install Liebert Nform 4 as described in 2.1 - Installation.
• Create a temporary folder on the Nform 4 server and copy the export files from the Export folder 

from the program folder where Liebert Nform 2.X was installed.
• On the Liebert Nform 4 server, open the Nform Tools window. To do this, click on the Start 

button, then click on Programs, Liebert Nform and finally Nform Tools. 

• In the Liebert Nform Tools window (below), click on the Tools menu, then on Import 2.5 Data.
• In the Directory box, enter the full path or click the Browse button to locate the folder 

containing the exported files, then click Open.

• Click Import. The import utility will temporarily stop the Nform service and import the 
appropriate files—the service will restart automatically when the Tools application is closed. 
A message confirms the process is complete.

• When finished, close the Tools application by clicking on the Application menu, then Exit (see 
18.3.2 - Application Menu - Close Nform Tools).
The Nform service will be restarted automatically on exit.

Import
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2.4.4 Import Exported Data From the Same Server

If Liebert Nform 4 will be installed on the same server, the installation will automatically detect the 
presence of the Liebert Nform 2.X application, import the data from the export folder (license keys, 
managed devices, shutdown clients and e-mail actions), then remove the Liebert Nform 2.X 
application.

A copy of the Liebert Nform 2.X data files and exported files will be saved.

• Install Liebert Nform 4 as described in 2.1 - Installation.
• If you select the Nform Remote Client Only option on a computer running a Liebert Nform 2.X 

client, server or both, you will have the option to uninstall the Nform 2.X client or server software 
automatically.

NOTE
The export MUST be run manually for the upgrade to import data properly from the Liebert 
Nform 2.X application.
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3.0 OVERVIEW

This section provides a quick look at the features available with various SNMP devices and the 
functions accessible through Liebert Nform’s desktop, tabs, menus and toolbar buttons.

3.1 The Viewer Window - Overview
The Viewer window is shown below. 

• The Menu Bar at top left offers access to all Liebert Nform features (see 3.1.2 - Menus):
• Application
• View
• Configure
• Tools
• Help

• Status Buttons in the top frame show the number of devices by condition (see 3.1.1 - Buttons). 
This top frame may be minimized to expand the Viewer Display Area. The device conditions are:

• No Communication
• Normal
• Alarm

• View Tabs determine which type of information—device status, navigation tree or alarm data—
is shown in the Viewer Display Area (see 3.1.1 - Buttons):

• Dashboard (the default view when the Viewer opens, shown above)
• Navigate
• Alarms

• The Viewer Display Area shows status, configuration or alarms information, depending on 
which view tab is selected (see 16.0 - Operation - Using the Viewer). The default Dashboard 
view above shows gadgets with three types of data for all devices:

• Device Status
• Alarm Status
• Alarm Severity

• Configuration Buttons in the bottom frame are shortcuts to Liebert Nform setup features (see 
3.1.1 - Buttons). These functions are also available from the Configure menu. This bottom frame 
may be hidden to expand the Viewer Display Area.

Status
Buttons

Configuration 
Buttons

View 
Tabs

Menu Bar

Viewer 
Display 
Area

Top Frame

Bottom 
Frame
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3.1.1 Buttons

Table 3 shows the buttons available in the Viewer and where to learn more about each.

Table 3 Desktop buttons - summary

Button Description For more information, see:

STATUS BUTTONS - Each button has three modes.
16.0 - Operation - Using 

the Viewer

No
Communication
Number of
devices not
communicating
below button

Gray symbol - all devices are 
communicating with server Click on this button to filter the

Dashboard view to show only
devices not communicating
with the server.
(Click again to toggle to 
show all devices.)

16.1.2 - Select Devices for 
Gadgets

Flashing - requires attention
1 or more devices not 
communicating with a 
configured computer

Normal
Number of
devices
operating
normally
below button

Green symbol - 1 or more 
devices operating normally Click on this button to filter the

Dashboard view to show only
devices operating normally.
(Click again to toggle to 
show all devices.)

16.1.2 - Select Devices for 
GadgetsFlashing - requires attention

no devices operating normally

Alarms Present
Number of
devices in alarm
below button

Gray symbol - no devices 
currently in alarm Click on this button to filter the

Dashboard view to show only
devices currently in alarm.
(Click again to toggle to 
show all devices.)

16.1.2 - Select Devices for 
GadgetsFlashing - requires attention

1 or more devices in alarm

SELECTED VIEW TABS - Click to change the view in the Viewer Display Area.

Dashboard
View status of configured devices in Detail area.

16.1 - Dashboard Tab

Navigate

View navigation tree with configured devices and floor plans, Web 
browser interface, parametric data, alarms, trend data and Web links in 
Detail area.

The arrow tab indicates that double-clicking opens the Navigate view in 
a separate window, which can be dragged to another monitor.

16.3 - Navigate Tab - 
Device

Alarms

View alarm data for all configured devices in Detail area.

The arrow tab indicates that double-clicking opens the Alarms view in a 
separate window, which can be dragged to another monitor.

16.4 - Alarms Tab

CONFIGURATION BUTTONS - Click for shortcuts to Configuration options.

Configure
Licenses

Shortcut to Configure > Licenses to add Liebert Nform 
licenses.

4.4 - Enter the License 
Key

Configure
Server
Options

Shortcut to Configure > Server Options to view or change 
global settings.

8.0 - Configuring Server 
Options

Configure
Devices Shortcut to Configure > Devices to add devices and floor plans. 9.0 - Configuring Devices

Configure
Actions

Shortcut to Configure > Actions to set up actions (e.g., send e-
mail, write file).

12.0 - Configuring 
Actions

Configure 
Users & Groups

Shortcut to Configure > Users and Groups to add user 
accounts and customize user options.

13.0 - Configuring Users 
and Groups
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3.1.2 Menus

The menu bar at the top of the Viewer window provides access to all Liebert Nform’s features: 
Application, View, Configure, Tools and Help. Each menu has a drop-down list of options, as 
shown in Table 4.

Table 4 Menu options - summary

Menu Option Function (Configuration button, if any) For more details, see:

Application Nform Tools Open the Nform Tools application 5.1 - Nform Tools

Register Product Register for Software Assurance 5.2 - Register Product

Restart Session Restart the Client session without logging out 5.3 - Restart Session

Login As
Log in with a different user name and password
without closing the Viewer

5.4 - Login As

Exit
Close the Viewer window (requires login the next
time the Viewer is opened)

5.5 - Exit

View
Show Expanded
Top Frame

Show large status buttons at top of window or
display smaller status buttons

6.1 - Show Expanded Top 
Frame

Show Expanded
Bottom Frame

Show or hide the configuration buttons at the bottom
of the window

6.2 - Show Expanded Bottom 
Frame

Full screen
Expand to full-screen display (no title bar, menu bar
or window frame) or restore to normal window

6.3 - Full Screen (F11)

Configure

Devices
Add devices and their properties to the
configuration

9.0 - Configuring Devices

Actions
Create actions—e.g., e-mail notifications—to
be executed when an alarm is received

12.0 - Configuring Actions

Shutdown 
Clients

Configure MultiLink 1.5 client computers that may
be selected for shutdown actions

11.0 - Configuring Shutdown 
Clients

Views
Add devices, floor plans and logical groups to the
configuration

10.0 - Configuring Views for the 
Navigate Tab

Users and 
Groups

Create new users and define access
privileges for groups of users

13.0 - Configuring Users and 
Groups

Licenses
Add licenses purchased from Emerson for
Liebert Nform or Liebert MultiLink

4.4 - Enter the License Key

Server 
Options

Change global settings—e.g., for language,
alarms, devices, e-mail servers, SNMP

8.0 - Configuring Server 
Options

Change 
Password

Create or change a password to use at login
4.3 - Change the User Password
13.1 - Add Individual Users

User 
Options

Customize user preferences for language, time zone,
alarm and other colors, visual and audible alerts

7.0 - Configuring User Options

Tools
Export

Export a text file of records with:
• Alarm History - recent alarms
• Action History - recently executed actions
• Data Log History - trend graphs of data points

Submenu items:
14.1 - Export Alarm History
14.2 - Export Action History
14.3 - Export Data Log History

Help

Contents Open Liebert Nform help to the Contents tab —

Index Open Liebert Nform help to the Index tab —

Supported
Device Types

Show a list of device types supported by the 
Nform software

—

Technical 
Support

Open Liebert Nform help to display contact
information for Liebert Nform technical support

—

Check for Updates Get software updates (w/ Manage Licenses permission) —

About Liebert
Nform

View details on Nform Viewer version, server,
database, installed license keys, registration,
how to contact technical support

4.4.3 - View License Key 
Information

Menu 
bar
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4.0 GETTING STARTED WITH LIEBERT NFORM

This section provides details on starting the Nform Viewer, logging in and entering license keys to 
allowconfiguring devices for monitoring.

The software comes with a built-in Administrator account with full access to configuration and 
monitoring. Other users may be added with any combination of viewing and configuration privileges.

Saving Configuration Changes

Changes to Liebert Nform’s configuration are made immediately and do not need to be saved before 
they take effect.

4.1 Start Liebert Nform 

To start the application:
• Double-click on the program icon, below left (if added to the computer desktop during installation).

OR
• Click the Start button, then Programs, Liebert Nform and finally Nform Viewer (above right).

4.2 Log on as Administrator and Connect to Server

The Login to Liebert Nform window opens, asking for a user name, password and the server where 
Liebert Nform was installed.

• On initial startup, the user name is Administrator and no password is required. There is no 
need to specify a server if the Viewer is started on the Nform server.

• User name: Enter your user name—if none assigned, enter Administrator (box filled in for 
initial startup).

• Password: Enter the password that was assigned to you—if none assigned, leave blank 
(none required for initial startup or when using the evaluation edition)

• Server: Enter localhost (box filled in if the Viewer is started on the Nform server)—if the 
Viewer is started on a client computer, enter the hostname or IP address of 
Nform server where Nform Full Package resides

• Click on the Login button.

NOTE
The Liebert Nform software makes automatic adjustments to operate correctly with the 
Windows firewall if enabled.

NOTE
If you have trouble logging in, click the About button for technical support information.

Program 
group

Program icon
(shortcut)
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4.3 Change the User Password

The Change Password menu item allows users to change their own passwords at any time, as long as 
they have permission to do so. 

This option also applies to users who have an account created for them with the User must change 
password at next login option (see 13.1 - Add Individual Users) and for initial startup of an 
evaluation edition.

To change the password from the Configure menu:

• Start the Viewer with permission to change the password (see 13.1 - Add Individual Users).
• Click on the Configure menu, then choose Change Password.

• Enter the existing password in the Old Password box. 
(During the first login, leave this box blank.)

• Enter a password in the New Password box.
The password is case-sensitive and must consist of two to 14 characters—with any combination of 
letters, numerals and symbols. Be sure to record the password in a secure place.

• Re-enter that password in the Confirm Password box.

For information on other ways to set passwords:

• For setting passwords in the Nform Startup Wizard on initial startup, see Section 2.3, especially 
2.3.1 - Set Administrator Account Password. 

• Passwords may also be assigned when creating or editing user accounts, as described in 13.1 - 
Add Individual Users.
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4.4 Enter the License Key
A Liebert Nform license key must be installed for full use of Liebert Nform’s features, as described in 
the following steps. If you purchased additional licenses, repeat the following steps to install each 
license.

If another license for either Liebert Nform or Liebert MultiLink® is added to a system without an 
internet connection, the steps in 2.3.4 - Registering Offline (Quarantined) Systems must be 
performed for the new license. Liebert Nform will display the reminder below.

Systems that are connected to the Internet will get the new license registered automatically as 
detailed in 2.3.3 - Enter License Keys and Register.

4.4.1 Add a Liebert Nform License Key
To install a Liebert Nform license key:

1. Start the Viewer with permission to manage licenses (see 13.2 - Assigning Users to Groups).
2. Click on the Configure Licenses icon at the bottom of the window (or click on the Configure 

menu, then choose Licenses).

3. In the Licenses window, click the Add button at the top right.
4. Read the license agreement, and click I accept to continue.
5. In the Add License window, enter the license key from the sticker on the CD case or the certificate 

provided by Emerson, then click OK. There is no need to enter hyphens (-) in the license key.

After installation, the license key numbers appear in the Licenses window or may be viewed through 
the Help menu. See 4.4.3 - View License Key Information.

NOTE
The license key delivered with Liebert Nform permits a certain number of devices and 
unlimited users. To purchase a supplemental license key for additional devices (30, 100 or 
500), contact your local Emerson representative or see Appendix C - Ordering Parts and 
Licenses From Emerson Network Power.

Configure 
Licenses
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4.4.2 Add a Liebert MultiLink 1.5 Shutdown License

To install a Liebert MultiLink 1.5 Shutdown license:

1. Start the Viewer with permission to manage licenses (see 13.2 - Assigning Users to Groups).
2. Click on the Configure Licenses icon at the bottom of the window (or click on the Configure 

menu, then choose Licenses).

3. In the Licenses window, click the Add button in the MultiLink License section.
4. Read the license agreement, then click I accept to continue.
5. In the MultiLink License File window, enter the full path of the license file (MLLKU.license) or 

click Browse to locate the Liebert MultiLink shutdown license obtained from Emerson Network 
Power.
For Liebert Nform Enterprise installations, this file is in the MultiLink\MLLKU folder on the 
NFORM-EPRISE CD. 
For Liebert Nform 2.X customers, this can be exported and copied from the Export folder in the 
program folder where Liebert Nform 2.X was installed.

6. Click OK. The license file contents will be converted and displayed as a Liebert Nform shutdown 
license key in the Licenses window.

After installation, the license key numbers appear in the Licenses window or may be viewed through 
the Help menu. See 4.4.3 - View License Key Information.

Configure 
Licenses
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4.4.3 View License Key Information

Users with Licenses access (see 13.2 - Assigning Users to Groups) may view information about 
installed license keys in either of two ways:

• Licenses Window
• Start the Viewer with permission to manage licenses (see 13.2 - Assigning Users to 

Groups).
• Click on the Configure Licenses icon at the bottom of the window (or click on the 

Configure menu, then choose Licenses).
• Click on a license key number to view a description in the Select License Details area. 

Choosing multiple license keys—with shift-click or control-click—will change the display to 
show details of all selected license keys.

• Help - About Liebert Nform Window
• Click on the Help menu at the top of the window, then click on About Liebert Nform.
• Click the License tab to view details of all license keys that are installed.

To remove a license key, see 19.2 - Deleting a License Key.

Configure 
Licenses
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5.0 USING THE APPLICATION MENU

The Application menu allows you to restart the Nform service without closing the Viewer, install 
definitions for new equipment purchased from Emerson, restart a session without logging out, log in 
as a different user and exit the application.

5.1 Nform Tools

This menu item provides quick access to the Nform Tools application. 

The application may be opened from the Start menu (see 18.1 - Open the Nform Tools Application 
From the Start Button) or directly from this menu item in the Viewer.

To open the Nform Tools application from the Viewer:

• (Windows XP and Server 2003 only) Log into Windows on the Nform server as a user with 
administrator privileges on that machine.

• Start the Viewer on the Nform server and log in as a user with start/stop server permission (see 
13.2 - Assigning Users to Groups).

• Click on Application, then Nform Tools.
• (Windows Vista, Server 2008 and later) A User Account Control (UAC) message appears, 

requesting your permission to start the application. Click Allow to continue.

See 18.0 - Using Nform Tools for complete details on the Nform Tools application.
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5.2 Register Product

This menu item allows you to register if the Nform system has never been registered or the 
registration has expired or will expire within 60 days (see 2.2 - Registering for Software 
Assurance).

To register or renew registration:

• Start the Viewer and log in as a user with permission to manage licenses (see 13.2 - Assigning 
Users to Groups).

• Click on Application, then Register Product.

• Proceed to the next two sections:
• 5.2.1 - Enter Customer Information for Nform and Software Assurance
• 5.2.2 - Enter License Keys and Register

NOTE
This menu item is disabled after the product is successfully registered.
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5.2.1 Enter Customer Information for Nform and Software Assurance

This window may have information filled in depending on the account used to log in:

• If you log in as a user with administrative privileges—other than the built-in Administrator 
account—some account user information is filled in. No new account will be created.

• If you log in as Administrator (built-in account), a second administrator account will be created.

User Information

In the top portion of the window, complete the following user information as needed:

• User Name: Enter a user name for the new account. This will be used to log on to Liebert Nform.
• Full Name: Enter the person’s name to identify the user.
• E-mail Address: Enter the person’s e-mail address. This will be used to log onto the Nform 

Support Web site.
• Password: Enter a password, then re-enter it in the Confirm Password box. The password is 

case-sensitive and must consist of six to 14 characters—with any combination of letters, numerals 
and symbols. Be sure to record the password in a secure place.

• Phone: Enter the user’s telephone number, including area code. This field is optional.
• To set up additional options for this user account, such as alternate contact information, click the 

Edit button to open the User Properties window (see 13.1 - Add Individual Users).

Software Assurance Check Boxes and Company Information
By default, the Use this information for Software Assurance registration option is checked to 
make it easy to register your product for Software Assurance. This option creates an account on the 
Nform Support Web site using the information at the top along with the company information at 
bottom. This Web site account will be used to register your product license keys so you may receive 
the full benefits of the Software Assurance program. You may skip this step if you prefer to register 
later.

• To register, check Use this information for Software Assurance registration and enter the 
following information. NOTE: This information will not be distributed to any outside company.

• Company: Enter your company name.
• Address 1 and Address 2: Enter street address or P.O. box and city.
• Country: Choose the country from the drop-down list.
• Postal code: Enter a postal code as needed for your location.

• To use this or an existing account for another Nform installation, check I already have a Software 
Assurance account. The e-mail and password entered above will be used for the SA account.

• To register later, remove the check mark from the Use this information for Software 
Assurance registration box.

• Click Next. A confirmation window indicates whether a user was created (above right). Click OK.

Confirmation - 
user created



Using the Application Menu

Liebert® Nform™ 35

5.2.2 Enter License Keys and Register

The final step in the startup wizard is to enter any license keys purchased with Liebert Nform.

Emerson recommends entering these keys now to simplify the setup process and proceed with 
registration.

This may be done at a later time; however, the system will operate in evaluation mode until a base 
license key is entered. See 4.4 - Enter the License Key.

To install a Liebert Nform license key:

1. In the Licenses window, click the Add button at the top right. (For details on using the Add 
button under MultiLink License, see 4.4.2 - Add a Liebert MultiLink 1.5 Shutdown License.)

2. Read the license agreement, and click I accept to continue.
3. In the Add License window, enter the license key from the sticker on the CD case or the certificate 

provided by Emerson, then click OK. There is no need to enter hyphens (-) in the license key.
4. If you purchased additional licenses, repeat Steps 1 to 3 to install each license.

After installation, the license key numbers appear in the Licenses window or may be viewed 
through the Help menu. See 4.4.3 - View License Key Information.

5. Click the Register button to complete the process. A confirmation dialog box appears if 
registration was successful. The following error message appears if the licenses could not be 
registered.
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5.3 Restart Session

When needed, you may restart the Client session without closing the Nform Viewer or having to log in 
again. To do this:

• Click on Application, then Restart Session.

5.4 Login As

When needed, you may log in with a different user name and password without closing the Nform 
Viewer. To do this:

• Click on Application, then Login As.

5.5 Exit

To close the Viewer window:

• Click on Application, then Exit. This action requires login the next time the Viewer is opened.

The Liebert Nform service keeps running in the background even after the Viewer window is closed. 
For details on the service, see 17.1 - Starting or Stopping the Liebert Nform Service.
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6.0 USING THE VIEW MENU

The View menu lets you quickly increase the size of the Viewer Display Area by minimizing the 
status buttons at the top, hiding the configuration buttons at the bottom or switching to full-screen 
display mode.

6.1 Show Expanded Top Frame

The default Viewer window has three large status buttons in the top frame. This top area may be 
minimized to enlarge the Viewer Display Area. The status buttons are functional whether the top 
frame is expanded or collapsed. (For details on the status buttons, see 3.0 - Overview.)

To expand or collapse the top frame:

• Start the Viewer.

• Click on View, then click on Show Expanded Top Frame to place or remove a check mark:
• Place a check mark  to show large buttons, as in the example below left. 
• Remove the check mark from the box  to minimize the status buttons, below right. The 

status buttons are still functional when minimized.

TOP FRAME EXPANDED
Large status buttons

TOP FRAME COLLAPSED
Minimized status buttons
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6.2 Show Expanded Bottom Frame

The default Viewer window has configuration buttons in the frame at the bottom of the window. 
These buttons may be hidden to enlarge the Viewer Display Area. All features available from the 
configuration buttons are still accessible from the Configure menu. (For details on the configuration 
buttons, see 3.0 - Overview.)

To expand or collapse the bottom frame:

• Start the Viewer.

• Click on View, then click on Show Expanded Bottom Frame to place or remove a check mark:
• Place a check mark  to show the configuration buttons, as in the example below left.
• Remove the check mark from the box  to hide the status buttons, below right.

BOTTOM FRAME EXPANDED
Configuration buttons

BOTTOM FRAME COLLAPSED
No configuration buttons
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6.3 Full Screen (F11)

The Viewer window may be maximized to full-screen display mode with no menu bar, then restored to 
its previous size, using either the F11 key or the View menu to toggle between views. 

Full-screen mode expands the Viewer window to fill the monitor. This is similar to the standard 
Windows Maximize-window mode, but also hides the window frame, title bar and menu bar. To reveal 
the menu bar while in full-screen mode, move the cursor to the top of the screen.

To do this:

• Start the Viewer.

• To enter full-screen display mode:
• Function keys: Press the F11 key.
• Menu options: Click on View, then on Full Screen.

• To restore the Viewer window to its previous size:
• Function keys: Press the F11 key.
• Menu options: Make the menu bar visible by moving the mouse to the top of the window. 

Click on View, then on Full Screen to remove the check mark .

Move cursor to top of window 
to reveal menu bar

FULL SCREEN DISPLAY MODE
No window frame, title bar or menu bar
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7.0 CONFIGURING USER OPTIONS

Users may customize their preferences to select:

• Language
• Time zone
• Colors for alarms, backgrounds and graphs 
• Preferences for visual alerts of alarms
• Preferences for audible alerts of alarms

The User Options window has four tabs that allow customizing a user’s view and alerts.

7.1 User Options - External Tab

Click the External tab in the User Options window for these options:

• Choose a language for the display of text in all Viewer menus, windows and dialog boxes in the 
Liebert Nform application.

• When finished, click the OK button to accept all changes in the User Options window.
• Restart the Viewer for the language change to take effect.
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7.2 User Options - General Tab

Click the General tab in the User Options window for these options:

• Display time zone: Choose Local time (the default) of the user’s workstation or Server time—
the time of the server where Liebert Nform is installed.

• In the Alarm Colors section, click the Unacknowledged, Acknowledged and Background 
buttons to customize the color schemes for the user’s alarms. These changes apply to display in 
the Alarms tab (see 16.4 - Alarms Tab).

• In the Color window, choose a color from the swatches, then click OK. 
(To define a new color, click the Define Custom Colors button to expand the Color window, then 
select a color using the slider tools or enter RGB values in the Red, Green and Blue boxes. Click 
OK when finished.)

• The new colors are displayed in the Alarm Colors section. Use the buttons to make additional 
changes as needed.

• When finished, click the OK button to accept all changes in the User Options window.

Choose 
from color 
swatches

. . . or define 
a custom color

Slider 
tools

Preview
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7.3 User Options - Visual Alerts Tab

Click the Visual alerts tab in the User Options window to specify how the user will be notified when 
a new alarm is received:

• Bring application to the foreground - the Viewer window comes to the foreground of the 
user’s computer screen.

• Flash taskbar button - the Liebert Nform button flashes in the Windows taskbar of the user’s 
computer screen.

• Display system tray popup message- a message appears above the Windows system tray.

For each option:

• Place a check mark  to select it (or remove the check mark to deactivate it).
• Choose a minimum level of alarm severity from the drop-down list. For example, if Warning is 

chosen, the selected option occurs for any alarm with Warning or higher level of severity.
• When finished, click the OK button to accept all changes in the User Options window.
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7.4 User Options - Audible Alerts Tab

Click the Audible alerts tab in the User Options window to specify whether sounds are assigned to 
alarm severity levels. Alarm sounds are disabled by default.

• To activate any alarm sounds, place a check mark  in the Enable Audible Alerts box (or remove 
the check mark to disable all sounds).

• For each alarm severity level (for example, Critical, Warning, Information):
• Choose a sound from the drop-down list—for example, Beep. The default is None.
• To listen to a sound, select it from the drop-down list, then click the right arrow button to the 

right of the list.
• When finished, click the OK button to accept all changes in the User Options window.

Click arrow 
to hear sound
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8.0 CONFIGURING SERVER OPTIONS

This feature allows you to specify global settings for configuration options. These options are selected 
by default in various configuration windows, but any option may be locally customized for a particular 
device or action.

1. Start the Viewer (see 13.2 - Assigning Users to Groups for permission required for various 
functions).

2. Click on the Configure Server Options icon at the bottom of the window (or click on the 
Configure menu, then choose Server Options).

3. The Server Options window has tabs for various types of options. Refer to the following sections 
for details on each tab.

Configure 
Server 

Options
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8.1 Server Options - General Tab
• Start the Viewer (see 13.2 - Assigning Users to Groups for access privileges).
• Click on the Configure Server Options icon at the bottom of the window (or click on the 

Configure menu, then choose Server Options).
• Click on the General tab. 

• In the Description box, enter the name of the server host computer where the software is 
installed.

• The Locale section requires permission to manage server parameters (see 13.2 - Assigning 
Users to Groups). 
To make changes:

• In the Language box, click on the drop-down list and choose a language to be used by the 
server when localized text is needed—primarily for actions and some alarm information.

• The service must be restarted before this change will take effect (see NOTE below).
• The Audit log file area requires permission to manage logging parameters (see 13.2 - Assigning 

Users to Groups). 
This section displays the name and size of the audit log, a record of logins and logouts and 
changes to the system configuration. Emerson recommends keeping the default settings.

• The default File name and full path is: C:\Nform\log\Audit.log.
• The default Maximum size of the audit log file is 10 MB.

• Click OK to save any changes.

• The Liebert RSD global value area requires permission to manage server parameters (see 13.2 - 
Assigning Users to Groups) 

• This feature allows you to set a global site ID for remote monitoring, which may be overridden for 
any device (see 9.2.4 - Liebert RSD Tab). To activate remote monitoring:

• Check the Enable Liebert RSD Support box to activate the function.
• Enter the appropriate ID in the Site ID box. (Note: The string is supplied by Liebert Services 

for users with Liebert Nform and a service contract.)

NOTE
If the language was changed, the service must be restarted for the change to take effect (see 
18.3.1 - Application Menu - Service).
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8.2 Server Options - Event Log Tab
• Start the Viewer with permission to manage logging parameters (see 13.2 - Assigning Users to 

Groups).
• Click on the Configure Server Options icon at the bottom of the window (or click on the 

Configure menu, then choose Server Options).
• Click on the Event Log tab.

• The Event log file area displays the name and size of the event log, a record of notifications and 
events affecting device communications. Emerson recommends keeping the default settings.

• The default File name and full path is: C:\Nform\log\Event.log.
• The default Maximum size of the audit log file is 20 MB.

• Place a check mark  in the Enable diagnostic event logging box to log notifications from any 
device—not just managed devices—as well as authentication notifications.

• Click OK to save any changes.
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8.3 Server Options - Alarms Tab
• Start the Viewer with permission to manage server parameters (see 13.2 - Assigning Users to 

Groups).
• Click on the Configure Server Options icon at the bottom of the window (or click on the 

Configure menu, then choose Server Options).
• Click on the Alarms tab.

• The Maximum viewable alarms box specifies the highest number of alarms—those not yet 
closed—that may be displayed in the viewer. The default is 500.

• Place a check mark  in the Enable auto-acknowledge box to automatically acknowledge new 
alarms with the specified level of severity. If this feature is enabled, choose the level of severity—
Information, Warning, Critical or user-defined levels—in the Severity box. 

• The Alarm Storage features specify criteria for storing and cleaning up alarms in the database.
• Alarms will be deleted from the database automatically after the number of days specified in 

the Maximum storage (days) box. The default is 90 days.
• Alarms will be deleted from the database automatically according to the amount of free space 

in the database if Enable free space monitoring is checked.
• The feature is always enabled (the Enable free space monitoring box is checked but 

disabled) when the embedded database is used. For an SQL Server database, place a check 
mark  to enable the feature (or remove the check mark to disable it).

• Specify the Maximum database size (default is 2,000 MB for the embedded database, 
10,000 MB for an SQL Server database).

• Specify the Minimum free space (default is 10%) to use as criteria for deleting records.
• Click OK to save any changes.
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8.4 Server Options - SMTP Tab
• Start the Viewer with permission to manage e-mail parameters (see 13.2 - Assigning Users to 

Groups).
• Click on the Configure Server Options icon at the bottom of the window (or click on the 

Configure menu, then choose Server Options).
• Click on the SMTP tab to specify SMTP mail servers for e-mail notifications.

SMTP Servers
• To configure a specific SMTP server, click the Add button. The SMTP Server window opens.
• In the Name box, enter the name of the server host computer where the software was installed.
• If desired, enter text to identify the server in the Description box.
• In the Hostname or IP address box, specify the outgoing mail server that this computer uses for 

outgoing e-mail—for example, mail.company.com or 192.168.0.18.
• The Port number box displays the IP port to be used as the SMTP port.

• The default is Use standard port (25), the most commonly used port. 
• If a different port is used, click Use custom port, then choose a number from the list.

• In the Sender’s address box, enter the e-mail address to use for all outgoing e-mail notifications—
for example, Support@company.com.
Any error messages from the e-mail system will be sent to this address.

• Click OK to return to the Server Options window.

Automatic
• If desired, enter an e-mail address in the Sender’s Address text box. 

This is required if you wish to choose the automatic server option for an e-mail action (see 12.2.1 - 
Configure E-Mail Actions), determining the recipient’s SMTP server based on the domain 
name. An Nform server with Internet access will send notifications directly to the recipient’s mail 
server, requiring no additional configuration and allowing for faster delivery.
NOTE: This address must be entered before the automatic server option may be used.

Save Changes

• Click OK in the Server Options window to save any changes.
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8.5 Server Options - Device Tab
• Start the Viewer (see 13.2 - Assigning Users to Groups for access privileges).
• Click on the Configure Server Options icon at the bottom of the window (or click on the 

Configure menu, then choose Server Options).
• Click on the Device tab.

• Global status polling options require permission to manage global device parameters (see 13.2 - 
Assigning Users to Groups). 
Choose an option to enable or disable global status polling. The option chosen to poll managed 
devices for communication and alarm status will apply to all devices. If polling is enabled globally, 
it may be disabled for individual devices (see 9.2.1 - Communications Tab).

• Priority: All devices will be polled according to a specified priority, either High or 
Low (default). The high or low priority may be changed for individual devices.

• Daily: All devices will be polled at a specified time every day. Specify the time of day using a 
24-hour clock in the format hh:mm—for example, 09:30 for 9:30 a.m. or 13:15 for 1:15 p.m.

• Interval: All devices will be polled at a specified interval. Specify the time interval in hours—
for example, approximately every 2 hours or every 8 hours.

• Disabled: No devices will be polled. This option may not be changed for individual devices.
• The Enable Emerson Protocol option requires permission to manage server parameters (see 

13.2 - Assigning Users to Groups). 
Place a check mark  in this box to use Emerson Network Power’s Emerson Protocol for 
communication with compatible Emerson devices via Ethernet or IEEE-485 links. 

• The Data Logging Storage features require permission to manage logging parameters (see 
13.2 - Assigning Users to Groups). 
Data logging requires a license with Advanced Communications (see Table 12).
Two types of criteria may be specified for storing and cleaning up logged data:

• Data will be deleted from the database automatically after the number of days specified in the 
Maximum storage (days) box. The default is 180 days.

• Data will be deleted from the database automatically according to the amount of free space in 
the database if Enable free space monitoring is checked.
• The feature is always enabled (the Enable free space monitoring box is checked but 

disabled) when the embedded database is used. For an SQL Server database, place a check 
mark  to enable the feature (or remove the check mark to disable it).

• Specify the Maximum database size (default is 2,000 MB for the embedded database, 
10,000 MB for an SQL Server database).

• Specify the Minimum free space (default is 10%) to use as criteria for deleting records.
• Click OK to save any changes.
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8.6 Server Options - SNMP Tab
The SNMP tab specifies global settings for trap ports, community strings and the login user name and 
password for Web cards. All but the trap receive port may be overridden for individual devices.

• Start the Viewer with permission to manage global device parameters (see 13.2 - Assigning 
Users to Groups).

• Click on the Configure Server Options icon at the bottom of the window (or click on the 
Configure menu, then choose Server Options).

• Click on the SNMP tab.
• The Trap receive port box displays the trap port to be used by the server to receive traps.

• The default is Use standard port (162), the most commonly used port.
• To specify another port, click Use custom port and choose a number from the drop-down list.

• In the Web card login section, enter the User name and Password to be used globally for all 
devices. The default is Liebert for both user name and password.

• In the Global values section, enter request and trap community strings to be used by all devices. 
In most cases, these will be the same. The defaults are:

• Request community: public (The request community string is case-sensitive and must match 
the community string entered in the SNMP card.)

• Trap community: public (The trap community string is case-sensitive and must match the 
community string entered in the SNMP card.)

• The Timeout box designates the number of seconds for a device to respond to an SNMP query. The 
default is 1000 milliseconds; Emerson suggests this value is appropriate in most cases. (If you 
receive an excessive number of timeout error messages, consider increasing the time.)

• The Retries box specifies the number of times to attempt polling a device for an SNMP query after 
no response. The default is 2.

• The Request port box displays the port to be used by the server to request traps.
• The default is Use standard port (161), the most commonly used port.
• To specify another port, click Use custom port and choose a number from the drop-down list.

• Click OK to save any changes.
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8.6.1 Server Options - SNMP Tab - SNMPv3
Liebert Nform supports SNMPv3 for devices that utilize the SHA1 or MD5 authentication protocols 
and the DES privacy protocol. Settings in the SNMPv3 portion of the SNMP tab will apply to all 
managed devices configured to use SNMPv3 (refer to 9.2.2 - Protocol Tab - SNMP).

In the SNMPv3 parameters box, enter the settings for accessing SNMPv3 devices. The user name, as 
well as the passphrase(s), must match one of the accounts in each of the devices on which SNMPv3 
will be employed. The user name and passphrase(s) must first be configured in each device that is to 
use SNMPv3. For information on configuring the account, refer to the user manual of the card in the 
device.

• In the User (security) name box, enter a name to use when accessing SNMPv3 devices.
The user name can be as short as one character. Leave this blank if SNMPv3 will not be enabled.

• Choose an Authentication protocol to be used. The default is None; options are SHA-1 and MD5.
If Authentication protocol is set to None, the Privacy protocol will not be available. Using the 
Authentication protocol does not require that the Privacy protocol be used.

• Enter an Authentication key. The key must have at least eight characters and no more than 64.
Record this key and store it in a secure area where it can be retrieved.

• Choose a Privacy protocol to be used. The default is None; the only option is DES.
The Privacy protocol will not be available if Authentication protocol is set to None.

• Enter a Privacy key. The key must have at least eight characters and no more than 64.
Record this key and store it in a secure area where it can be retrieved.

• Click OK to save your changes.

NOTE
Liebert Nform pemits only one set of credentials for accessing SNMPv3 devices. The system 
administrator should store the user name and keys in a place accessible by all personnel 
authorized to access the SNMPv3 devices.
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8.7 Server Options - Trap Forwarding Tab

Enabling the Trap Forwarding global setting sends all selected types of traps collected by Liebert 
Nform to a specified computer. This may be overridden for any particular device with the Enable Trap 
Forwarding For This Device check box (see 9.2 - Edit the Device Properties).

The Trap Forwarding feature differs from the Forward Trap action, which may be configured to 
forward individual traps to multiple destinations (see 12.2.5 - Configure Forward Trap Actions 
for details).

• Start the Viewer with permission to manage SNMP trap forwarding (see 13.2 - Assigning Users 
to Groups).

• Click on the Configure Server Options icon at the bottom of the window (or click on the 
Configure menu, then choose Server Options).

• Click on the Trap Forward tab, which specifies global settings for two features:
• Trap Forwarding - forward incoming traps to another system: 

• This feature is disabled by default. 
To activate, place a check mark  in the Enable box. Even if enabled globally, this feature 
may be disabled for individual devices.

• Place a check mark  in each Types box as needed to select the kinds of traps to forward: 
• Enterprise
• Generic (e.g., cold start)
• Authentication

• In the Hostname or IP address box, specify the computer where traps should be forwarded.
• In the IP Port box, specify whether to use the standard port 162 (recommended) or a custom 

port for this global setting.
• Event Log - log each trap that is forwarded to another system: 

• This feature is disabled by default. 
To activate, place a check mark  in the Enable trap forward event logging box. Even if 
enabled globally, this feature may be disabled for individual devices.

• When finished, click OK to save any changes (or Cancel without saving).



Configuring Server Options

Liebert® Nform™ 53

8.8 Server Options - Updates Tab

Updates to the Liebert Nform software and updated device support (DTD) files are available to users 
who have registered their Nform system for Software Assurance (see 5.2 - Register Product). 

Use the Updates tab to specify whether and when to have Nform automatically check for updates.

Regardless of the settings specified in this window, you may check for updates at any time using the 
Help menu to (see 15.5 - Check for Updates).

• Start the Viewer with permission to manage licenses (see 13.2 - Assigning Users to Groups).
• Click on the Configure Server Options icon at the bottom of the window (or click on the 

Configure menu, then choose Server Options).
• Click on the Updates tab.
• Choose an option of checking for updates in the Product Updates and DTD Updates sections:

1. Download updates and notify me when finished.
2. Notify me but don’t download them (the default).
3. Don’t check for updates (see 15.5 - Check for Updates to check manually). 

• Specify a schedule in the Check for Updates area for Option 1 (download) or 2 (notify):
• Decide how often Nform should check for updates by clicking on:

• Click on Daily to check for updates every day.
• Click on Weekly to check for updates once a week, then choose the day of the week (Sunday 

through Saturday).
• Click on Monthly to check for updates once a month, then choose the day of the month 

(1 through 28—1 for the first day of the month, 2 for the second, and so on).
• Enter the time of day to check for updates in the Time box (hh:mm using a 24-hour clock).

• When finished, click OK to save any changes (or Cancel without saving).

The Updates Available button shown below appears in the Viewer when updates are available. 
Clicking on this button opens the Updates Available window (see 15.5 - Check for Updates).
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9.0 CONFIGURING DEVICES

This section describes how to configure devices that will be monitored, add floor plans as visual aids, 
set up the navigation tree and view or change settings for alarm, trap and SNMP services.

Liebert Nform can monitor and manage any device with a Device Type Definition (DTD); many DTDs 
are installed with the application. 

If you have purchased a Device Type Definition (DTD) for new equipment from Emerson, you must 
first install the DTD before the device may be added to the configuration (see 18.5.1 - Tools Menu - 
Install DTD).

9.1 Add Devices to the Configuration
Three methods are available for adding devices to the Nform configuration. The software can detect 
device properties with any of these methods.

Devices may be added:

• by entering the hostname or IP address of an individual device (see 9.1.1 - Add a Single Device)
• by entering a range of IP addresses for automatic detection of supported devices on a network (see 

9.1.2 - Detect Devices on a Network)
• by importing devices from a file of device properties (see 9.1.3 - Import Devices From a File)
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9.1.1 Add a Single Device

Devices may be added one at a time through this feature. 

1. Start the Viewer with permission to configure devices (see 13.2 - Assigning Users to Groups).
2. Click on the Configure Devices icon at the bottom of the window (or click on the Configure 

menu, then choose Devices) to open the Managed Devices window.
3. Click the Add button to open the Nform Add Devices wizard, shown below right.

4. Click on Add a single device.
5. In the Add a Single Device window, below left, enter the hostname or IP address of the device you 

wish to add.
6. To automatically detect the description, device type, protocol and other details about the device, 

place a check mark  in the Obtain settings from device box.
7. Click Next.

8. The Customize Properties window, above right, displays key details for the device. 
If you wish to view or make changes to the properties at this time, click the Edit button, then 
refer to 9.2 - Edit the Device Properties. Changes may be made at any time.

9. Click Finish. 
10. A message confirms the device was added properly. Click OK, and the Managed Devices window 

displays the newly added device.
11. Click Close to return to the viewer.

Configure 
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9.1.2 Detect Devices on a Network

The auto discovery feature speeds up configuration with automatic detection of multiple devices 
within a range of IP addresses on a network.

To use Auto Discovery to detect devices on the network:

1. Start the Viewer with permission to discover new devices (see 13.2 - Assigning Users to 
Groups).

2. Click on the Configure Devices icon at the bottom of the window (or click on the Configure 
menu, then choose Devices) to open the Managed Devices window.

3. Click the Add button to open the Nform Add Devices wizard, shown below right.

4. Click on Discover new devices to add.
5. In the Discover Unmanaged Devices window, below left, enter ranges of IP addresses to search:

• Enable - Place a check mark  for each range you wish to search now. Each range remains 
available for future searches until removed by clicking the Delete row button.

• Start IP address - Click in the box and enter the lower end of the range—e.g., 198.162.0.20.
• End IP address - Click in the box and enter the upper end—198.162.0.30.

Two columns display results from previous searches:
• Not mgd is the number of devices found but not yet added to the Managed Devices list.
• Unknown is the number of devices found but not currently supported by the software.

6. Click Next to start the Auto Discovery process. The Search Progress window opens, below right.

7. When the search is complete, the progress bar shows 100%. Click Next.

Configure 
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8. The Add Discovered Devices window shows all supported devices detected during the search. You 
may add as many devices as allowed by your license. Review the list and:

• Place a check mark  next to each device you want to add to the list of managed devices.

Click Select all to add check marks to all devices.
• Remove check marks from devices you do not want to have managed. 

Click Clear all to remove all check marks.
• Click the Edit button to view all properties or make changes, then refer to 9.2 - Edit the 

Device Properties. Changes may be made at any time.
9. Click Finish.
10. A message confirms the device was added properly. Click OK, and the Managed Devices window 

displays all devices that have been added to the configuration.
11. Click Close to return to the viewer.
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9.1.3 Import Devices From a File

This section describes how to use the import option in the Add Devices wizard to import devices from 
a file containing device properties. 

The file may be generated from the Export Devices feature (see 9.4 - Export Managed Device 
Configurations to a File) or created from a template based on the generated file. An exported file 
will have a header line inserted as a comment with an exclamation point (!) at the beginning of the 
line. It is a good practice to use header lines in the import files as well. Lines containing device 
definitions must have values for the first three fields for each device. Other fields are optional.

To import devices from a file:

1. Start the Viewer with permission to discover new devices (see 13.2 - Assigning Users to 
Groups).

2. Click on the Configure Devices icon at the bottom of the window (or click on the Configure 
menu, then choose Devices) to open the Managed Devices window.

3. Click the Add button to open the Nform Add Devices wizard, shown below right.

4. Click on Import devices from a file to open the Add Device window shown below.
5. Specify the file to be imported: enter the full path in the File box or click the Browse button to 

locate the file, then click Open.
6. Select the appropriate Delimiter option for the type of delimiter used in the file. The default is 

Comma (,); other options are Semicolon (;),.Tab and Tilde (~).
7. Click Next to begin the import process. If at least one device is imported, proceed to Step 8.

If there are errors in an import operation, the same Add Devices window remains open (as shown 
above). For more information, open the text file named DeviceImportErrors.txt in the user 
subdirectory of the Nform installation.

Configure 
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8. The Add Discovered Devices window shows all supported devices detected during the import 
operation. You may add as many devices as allowed by your license. Review the list and:

• Place a check mark  next to each device you want to add to the list of managed devices.

Click Select all to add check marks to all devices.
• Remove check marks from devices you do not want to have managed. 

Click Clear all to remove all check marks.
• Click the Edit button to view all properties or make changes, then refer to 9.2 - Edit the 

Device Properties. Changes may be made at any time.
9. Click Finish.
10. A message confirms the device was added properly. Click OK, and the Managed Devices window 

displays all devices that have been added to the configuration.
11. Click Close to return to the viewer.



Configuring Devices

Liebert® Nform™ 60

9.2 Edit the Device Properties
Many settings are automatically entered—some from global settings (see 8.0 - Configuring Server 
Options) and some from automatic detection of device settings (see 9.1 - Add Devices to the 
Configuration). Most of these settings may be changed.

To edit the properties of a device:

• Start the Viewer with permission to configure devices (see 13.2 - Assigning Users to Groups).
• Click on the Configure Devices icon at the bottom of the window (or click on the Configure 

menu, then choose Devices) to open the Managed Devices window. This window is also accessible 
from the Edit button from any device window.

• Click the Edit button to open the Device Properties window, shown below right.

Device Name and Characteristics

• Edit the name and description at the top of the window as needed:
• Name - An identifying name for the device that is displayed in the viewer and may appear in 

notifications and logs—for example, UPS_192.168.0.25.
• Description - Additional text to describe the device—e.g., Liebert GXT UPS/Web Card.

• To change the type of device, click in the Device Type list and choose from the supported devices.
• The Protocol box entry—for example, SNMP—varies according to the type of device selected. To 

change this for a custom device, click in the Protocol list and choose from the supported protocols.

Configure 
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9.2.1 Communications Tab

The Device Properties window has two tabs. The Communications tab is shown below.

• Hostname or IP Address
• For an SNMP device, enter the device’s domain name or IP address; if needed, check with the 

System Administrator for that information.
• For a device using the Emerson Protocol—for example, the Liebert MPX—via BACnet router 

through MSTP (RS-485), enter the address of the BACnet router for this device (see 9.2.3 - 
Protocol Tab - Emerson Protocol).

• Device has a web server - This box should be checked to allow viewing device information 
through a Web browser. The device must have an SNMP card that supports a Web interface.

• URI - Leave this box blank (default) to use the device’s hostname or IP address to access the Web 
interface. To override this, enter an alternate address in this box.

• Test - Click this button to connect to the device via the Web interface.
• Status polling - Options vary depending on the choice made in 8.5 - Server Options - Device 

Tab, as shown below. The options for individual devices may be customized as follows:

• Enable trap forwarding for this device - Place a check mark  to activate this feature.
• Timeout and Retries: The global values will be used by default. To change this, place a check 

mark  in the Override Global Value check box, then enter values for this device in the Timeout 
and Retries boxes (see 8.6 - Server Options - SNMP Tab).

Global option Status polling Options for customizing individual devices

Priority
• High - device will be polled approximately every 2 to 5 seconds *
• Low (default) - device will be polled approximately every 20 seconds *
• Disabled - no polling will occur for this device

Daily
• Disabled - no polling will occur for this device
• If enabled, all devices will be polled at the same specified time each day

Interval
• Disabled - no polling will occur for this device
• If enabled, all devices will be polled at the same specified interval

Disabled
• None—this option disables the polling option for all devices 

(to change polling for an individual device, the global option must be changed)

 * Polling interval for high or low priority varies by total number of devices
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9.2.2 Protocol Tab - SNMP

The Device Properties window has three tabs; the second tab varies according to the protocol used by 
the selected device. The SNMP tab is shown below.

Option Notes

IP port

The default is Use global port (161), the most commonly used port. 
The IP port corresponds to the Request port in the Server Options global settings (see 8.6 - Server 
Options - SNMP Tab).
• To specify a different port, click Use custom port and choose a number from the drop-down list.

SNMP
version

For devices that support newer versions of SNMP, this option provides a way to select the SNMP 
version for a specific device—for example, from SNMPV2c to SNMPv1—to help troubleshoot 
communication problems with the device.
SNMPv1—unencrypted protocol
SNMPv2c—unencrypted protocol
SNMPv3—protocol that can use authentication and be encrypted

Only devices that are capable of SNMPv3 communication will have the SNMPv3 choice shown. If 
SNMPv3 parameters have been configured, then that choice may be selected here to use v3 
communication with the device (refer to 8.6.1 - Server Options - SNMP Tab - SNMPv3).

Request
community

The global value displayed below the text box (see 8.6 - Server Options - SNMP Tab) will be used 
by default.
• To change this value, place a check mark  in the Override Global Value check box and enter a 

new value in the text box.
Trap
community



Configuring Devices

Liebert® Nform™ 63

9.2.3 Protocol Tab - Emerson Protocol

The Device Properties window has two tabs; the second tab varies according to the Protocol for the 
selected device. The Emerson Protocol tab is shown below.

• If using the Emerson Protocol via BACnet router through MSTP (RS-485):
• Click to place a check mark  in the Device is serial via BACnet router box. By default, 

this setting is disabled.
• Enter a number in the MSTP Network box to indicate the network number.
• Enter a number in the MSTP Node box to specify the node where the device is connected.
• Click on the Communications tab, then enter the address of the BACnet router for this 

device in the Hostname or IP Address box (see 9.2.1 - Communications Tab).
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9.2.4 Liebert RSD Tab

The Device Properties window has a third tab, Liebert RSD, that appears only when the Global 
Setting for Liebert RSD is activated (see 8.1 - Server Options - General Tab), as shown below.

• To override the global setting for this device:
• Click to place a check mark  in the Override Global Value box.
• Enter a different string in the text box below the Override Global Value box.

• Enter a string in the Device Tag box. This value is assigned by Liebert Services for devices that 
are covered by a Liebert Services contract.
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9.2.5 Info Links

You may define a link to a Web page or a file for a device, an area or a logical group. These links are 
accessible in the Navigate tab (see 16.3.5 - Navigate - Info Links View).

• To open the Information Links window for:

Permanent links—gathered during Auto Discovery of devices—may not be edited or deleted. 
• To add a user-defined link, click the Add button to access the Link details area. 

• Enter a descriptive name for the link in the Name box.
• Enter the full link in the URI box (e.g., www.liebert.com or c:\text.txt).
• Click on the Test button to verify the designated Web page or file opens.
• Click the Save button. The link appears under the heading User-defined.

• To change a user-defined link:
• Click on the link to select it.
• Click the Edit button, then make changes as needed.
• Click the Save button.

• To remove a user-defined link, click on the link, then click the Delete button.
• Click OK to save any changes and close the window (or Cancel to close without saving).

• Devices: Click Info Links in the Device Properties window 
(shown below). 

• Areas: Click Info Links in the Area Properties window 
(see 10.2 - Add or Edit an Area).

• Logical 
Groups:

Click Info Links in the Group Properties window 
(see 10.4.1 - Group Properties - Logical Groups).
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9.2.6 Alarms and Data

Alarms and Data - Alarms Tab

To view or change the name or severity level of alarms for this device:

• Start the Viewer with permission to edit device definitions (see 13.2 - Assigning Users to 
Groups).

• Click on the Alarms and Data button in the Device Properties window to open the Device 
Alarms and Data window, then click the Alarms tab to view all system-defined alarms for this 
device (below right).

• To change a name, click on an alarm at the top of the window, then enter text in the Name box in 
the User-Defined area (lower right corner). 

• To change the severity, click on an alarm, then choose from the Severity list—e.g., Warning.
• Click Commit to save these changes and keep the window open.
• When finished, click OK to save all changes and close the window. (Or click Cancel to close 

without saving changes.) 
• The next time the window is opened, a check mark appears to the left of a System-Defined Name 

that has been redefined; the User-Defined Name column displays the new name.
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Alarms and Data - Data Tab

To view or change the name of data items for this device:

• Start the Viewer with permission to edit device definitions (see 13.2 - Assigning Users to 
Groups).

• Click on the Alarms and Data button in the Device Properties window to open the Device 
Alarms and Data window, then click the Data tab to view all system-defined data points for this 
device (below right).

• To change a name, click on a data point at the top of the window, then enter text in the Name box 
in the User-Defined area (lower right corner).

• Click Commit to save these changes and keep the window open.
• When finished, click OK to save all changes and close the window. (Or click Cancel to close 

without saving changes.) 
• The next time the window is opened, a check mark appears to the left of a System-Defined Name 

that has been redefined; the User-Defined Name column displays the new name.
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9.2.7 Data Logging

This feature requires a license with Advanced Communications (see Table 12).

Data logging may be used to collect real-time data continuously at fixed intervals to track the 
condition of a device. 

This time-based feature differs from the event-based Read Data action, which may be used to collect 
real-time data after being triggered by an event (see 12.2.6 - Configure Read Data Actions).

Both features collect the same type of data, which may be viewed in a trend graph (see 16.3.4 - 
Navigate - Trends View) or exported to a text file (see 14.3 - Export Data Log History).

Items selected for data logging will have a check mark in the Log column in the Device Data Logging 
window, shown below, and the Trend Data Selection window (see 16.3.4 - Navigate - Trends View).

To view or change the items selected for data logging for this device:

• Start the Viewer with permission to configure data logging (see 13.2 - Assigning Users to 
Groups).

• Click on the Data Logging button in the Device Properties window to open the Device Data 
Logging window.

• Each data item appears with its name, units of measurement and a brief description. Use the Log 
check boxes to choose which data items to log:

• Click to place a check mark  to the left of any data item. (Click again to remove a check 
mark.)

• Click the Select all button to check all items. 
• Click Clear all to remove all check marks.

• In the Sampling Interval (minutes) box, specify how often to collect readings of the selected 
data items from the device.

• When finished, click OK.
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9.3 Configure Maintenance Mode

Devices may be placed in maintenance mode, which prevents device-related alarms from triggering 
configured actions, including user notifications. Alarms are logged (see 16.4.3 - Informational Icons 
in the Navigation Tree), but will not generate actions or notify users. Devices may be placed in 
maintenance mode—manually or at a scheduled time—or returned to normal.

When a device is in maintenance mode, the images in the navigation view will change from status 
icons to maintenance icons, as shown below. 

• The floor plan in the right side of the window shows Device01 and Device02 with maintenance 
icons, indicating both devices are in maintenance mode. 

• In the tree at left, the same two devices appear with a smaller version of the maintenance icon, 
above a status icon such as No Communication. 

• For details about status icons, see 16.4.3 - Informational Icons in the Navigation Tree.
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9.3.1 Shortcuts to Place Devices Into or Out of Maintenance Mode

• In the Navigate view, right-click on an area to open to set the Maintenance Mode for all devices in 
that area. The following context-sensitive menu appears:

• In the following example, choosing Maintenance from the menu for an area places all devices in 
that area in Maintenance Mode (note Maintenance icon). Toggle the mode by clicking again to 
take all devices out of Maintenance Mode (the icon will change). 

• In the Navigate view, right-click on a single device that is not part of an area to reveal the same 
menu options.

• For an area or a single device, click on Configure Maintenance to set the options as described 
in the next section, 9.3.2 - Configure Maintenance Mode.
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9.3.2 Configure Maintenance Mode

To configure maintenance mode:

• Start the Viewer with permission to configure devices (see 13.2 - Assigning Users to Groups).
• Click on the Configure Devices icon at the bottom of the window (or click on the Configure 

menu, then choose Devices) to open the Managed Devices window. This window is also accessible 
from the Edit button from any device window.

• Highlight any devices you wish to configure for a particular Maintenance Mode, using standard 
shift-click and control-click methods to select multiple devices.

• Click the Maintenance button, and the Device Maintenance window opens, shown below right.

• Choose the type of maintenance mode to apply to selected devices:
• Normal - cancel scheduled maintenance, take devices out of maintenance mode
• Manual maintenance - immediately place devices in maintenance mode
• Scheduled maintenance - specify a time period to place devices in maintenance mode

• For the Scheduled maintenance option, specify the time period (required) and a reason 
(optional):

• Start Date - choose the date (yyyy-mm-dd) and time (hh-mm using a 24-hour clock)
• Specify the ending time by choosing either of the following options. If you enter an End Date, 

the Duration is automatically adjusted; if you enter the Duration, the End Date is adjusted.
• End Date—choose the date (yyyy-mm-dd) and time (hh-mm using a 24-hour clock) or 
• Duration—specify the length of the time period in minutes.

• Reason—enter descriptive text to help identify the purpose of the scheduled maintenance. 
This text will be copied to the Incident field in the alarm log for any alarm that occurs while 
the device is in maintenance mode. This applies only to scheduled maintenance.

• When finished, click OK. 
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9.4 Export Managed Device Configurations to a File
This feature allows you to export the basic configuration information for selected managed devices to 
a field-delimited text file that may be imported back into the same or another Nform configuration or 
into a spreadsheet. The delimiter may be a comma, semicolon, tab or tilde.

The generated file may be used as a template to create devices, as long as the same format is used. 
The first line contains field names in a comment line beginning with an exclamation point (!). The 
first three fields must contain data for each device. Other fields are optional.

To export managed device configurations to a file:

• Start the Viewer with permission to configure devices (see 13.2 - Assigning Users to Groups).
• Click on the Configure Devices icon at the bottom of the window (or click on the Configure 

menu, then choose Devices) to open the Managed Devices window. This window is also accessible 
from the Edit button from any device window.

• Highlight any devices to be exported, using standard shift-click and control-click methods to 
select multiple devices.

• Click the Export button, and the Export Devices window opens, shown below right.

• Specify the file to be created: enter the full path and file name in the File box or click the Browse 
button to locate the folder, then enter a file name and click Open.

• Select the preferred Delimiter option to be used in the file. The default is Comma (,); other 
options are Semicolon (;),.Tab and Tilde (~).

• Click Export to begin the export process. When the process is complete, a window displays a 
message that the export operation was successful (shown below) or had errors.
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10.0 CONFIGURING VIEWS FOR THE NAVIGATE TAB

The view in the Navigate tab may be customized to create views for different users, organize devices 
into groups or add graphic floor plans as visual reminders of where devices are located. See 16.3 - 
Navigate Tab - Device for details.

A default view called All Devices is created automatically, then altered as devices are added to or 
deleted from the Managed Devices list. Areas may be added and devices rearranged in the All Devices 
view as in any other view, but the All Devices view may not be deleted. 

To configure views:

• Start the Viewer with permission to configure navigation views (see 13.2 - Assigning Users to 
Groups).

• Click on the Configure menu, then choose Views.
• The Navigation Views window displays the default All Devices view and any other configured 

views. 
• Options in this window include:

• Add to create a view - see 10.1 - Add or Edit Views.
• Copy to create a new view based on a selected view - see 10.1 - Add or Edit Views.
• Edit to make changes to an existing view - see 10.1 - Add or Edit Views.
• Delete to remove a view from the list - see 10.1 - Add or Edit Views.
• Logical groups: for details, refer to 10.4 - Create Logical Groups.
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10.1 Add or Edit Views

To create or edit a customized view:

1. Start the Viewer with permission to configure navigation views (see 13.2 - Assigning Users to 
Groups). 

2. Click on the Configure menu, then choose Views to open the Navigation Views window.
3. Choose one of these options (All Devices is automatically generated from devices added to the 

Managed Devices list—it may be edited with a new name or copied, but not deleted):
• Click Add to create a new view.
• Click on an existing view, then click Edit to make changes to the selected view.
• Click on an existing view, then click Copy to create a new view based on the selected view.
• Click Delete to remove a view. This button is disabled when the All Devices view is selected.

4. In the Navigation View Properties window, shown above right:
• Enter a short name in the Name box that will appear in the Navigation Views window. 
• In the Description box, enter additional text to identify the view, if desired.
• The Navigation View Tree shows how devices will appear in the Navigation view. 
• The Available Devices list at right shows all devices that have not been assigned to the tree.
• Use standard shift-click and control-click methods to select multiple items.
• To move devices between the Navigation View Tree and the Available Devices list:

• Select one or more items, then drag-and-drop to the desired location. 
• Another method is to select items, then use the left and right arrows on the screen.

• To move items up or down in the tree at left:
• Select one or more items, then drag-and-drop to the desired location.
• Another method is to select items, then use the up or down arrows on the screen.

• To add an area to the tree, proceed to 10.3 - Place Devices in Floor Plans.
5. Be sure to click OK to save any changes (or click Cancel to close the window without saving).
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10.2 Add or Edit an Area
To add or edit an area in the navigation view:

1. Start the Viewer with permission to configure navigation views (see 13.2 - Assigning Users to 
Groups). 

2. Click on the Configure menu, then choose Views to open the Navigation Views window.
3. Open the Navigation View Properties window (see 10.1 - Add or Edit Views).
4. Choose one of these options to open the Area Properties window:

• Click Add to create a new area.
• Click on an existing area, then click Edit to make changes to the selected area.
• Click on an existing area, then click Copy to create a new view based on the selected area.

5. In the Area Properties window:
• Enter a short name in the Name box that will appear in the Navigation view—e.g., AreaD.
• In the Description box, enter additional text to help identify the area.
• Add an Image to an Area (Optional)

• To add an image such as a floor plan to the area, enter the full path and file name of the 
graphic file or click the Import image button in the Locator Map section to locate the file. 
Refer also to 10.3 - Place Devices in Floor Plans.

• A copy of the imported graphic file will be placed in the locatormap folder, a subfolder of 
the user folder in the Nform application folder. 

• Contact Emerson Network Power for custom-built floor plans—or create a floor plan. 
• Floor plans may be standard bitmap (JPG, GIF, BMP, PNG, TIFF, EXIF) or metafile (EMF, WMF) 

format.
• Add a Link to a Web Page or File (Optional) 

• To add a link to a Web page or file, click the Info Links button (see 9.2.5 - Info Links).
• Click OK to close the Area Properties window. 
• Be sure to click OK in the Navigation View Properties window to save the changes.

6. Move devices to areas as needed (see 10.1 - Add or Edit Views).
7. To remove an area from the tree, click on the area, then click Delete.
8. Click OK in the Navigation View Properties window to save the changes.
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10.3 Place Devices in Floor Plans

After adding a floor plan image to an area window (see 10.2 - Add or Edit an Area), to place a device 
in a floor plan map:

1. Start the Viewer with permission to configure navigation views (see 13.2 - Assigning Users to 
Groups). 

2. Click on the Configure menu, then choose Views to open the Navigation Views window.

3. Open the Navigation View Properties window (see 10.1 - Add or Edit Views).

4. In the Navigation View Tree, click on an area with a floor plan image, then click on the 
Floorplan button. 

5. In the Floorplan Properties window (below right):

• All devices that have been added to this area appear at the top of the window as status icons.

• Click-and-drag icons to any location on the floor plan.

• Use the Image Size slider bar to make all icons larger or smaller.

• Place a check mark  in the Show Labels box to reveal all device names.

• Labels may be moved all at once using the Default Label Position buttons: Above, Below, 
Left or Right. To move an individual label, click-and-drag the label to any position on the 
floor plan. When manually repositioned, labels keep the same position relative to their icons 
even if the icon is moved or the Default Label Position is changed for all labels.

Available 
devices 
at top

Device moved 
to floor plan map
Medium icon size, 
label below icon
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6. Right-click on an area in the floor plan that does not have a label for a pop-up menu with 
additional options that affect all labels for icons in this floor plan. 

The options are:  
• Default Label Properties - click to open the Label Properties window 

(see Step 8) to specify properties for all labels that have not been 
customized, as described in Step 7.

• Reset All Label Properties - revert to the default properties for all labels that have been 
customized.

• Reset All Label Positions - revert to the default position for all customized labels.
7. Right-click on an individual label for a pop-up menu with additional options 

that affect only the selected label. The options are:
• Label Properties - click to open the Label Properties window (see Step 8) 

to customize properties for this label only.
• Reset Label Properties - revert to the default properties for this label.
• Reset Label Position - revert to the default position for this label.

8. The Label Properties window shown below is accessible by right-clicking on the floor plan outside 
labels (Step 6) or on an individual label (Step 7). 

• Click the Font Options button to change the font, style and size in a standard Font window.
• Place a check mark  in the Show Border box to draw a border around label text.
• Click Foreground Color to open a Color window and change the label text color.
• Click Background Color to open a Color window and change the label background color.

9. Click OK to save changes (or Cancel to close the window without saving).
10. Click OK in the Navigation View Properties window. A window displays a message that the 

configuration has changed and the session will be restarted.

Right-click on 
area away from 
labels to change 
all labels

Right-click 
on a label 
to customize 
the selected 
label
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10.4 Create Logical Groups

Logical groups may be used to configure Liebert Rack PDUs—Liebert MPX and Liebert MPH 
devices—using a hierarchical structure starting at the PDU level, down to the branch and receptacle 
levels.

• The status of various components may be viewed—for example, power and current, as shown 
below. 

• Control functions are also available, as shown in the example below: receptacles may be turned on 
and off individually and in groups through the Liebert Nform software.

To create a logical group:

1. Start the Viewer with permission to configure navigation views (see 13.2 - Assigning Users to 
Groups).

2. Click on the Configure menu, then choose Views.
3. Click on the Logical groups button.

NOTE
In this release of the Liebert Nform software, logical groups apply only to Liebert MPX and 
Liebert MPH devices. 

Logical group features will be hidden or disabled if the list of managed devices has no Liebert 
MPX or Liebert MPH devices.

Logical
group
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4. The Logical Group Properties window displays a tree at left and available modules at right. 
Choose one of these options to open the Group Properties window:

• Click Add to create a new logical group.
• Click on an existing group, then click Edit to make changes to the selected group.
• Click on an existing group, then click Copy to create a new group based on the selected group.

5. To add or edit a logical group, see 10.4.1 - Group Properties - Logical Groups.
6. To remove a group from the tree, click on the group, then click Delete.
7. To move a group in the tree, click on the group, then use the up and down arrows in the center.
8. Click OK to save any changes.
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10.4.1 Group Properties - Logical Groups

To open the Group Properties window, see 10.4 - Create Logical Groups. 

• Enter a short name in the Name box that will appear in the Navigation view—e.g., Group1.
• In the Description box, enter additional text to help identify the logical group, if desired.
• To add a link to a Web page or file, click the Info Links button (see 9.2.5 - Info Links).
• Click OK to close the window.
• Be sure to click OK in the Logical Group Properties window to save the changes.
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11.0 CONFIGURING SHUTDOWN CLIENTS

This feature requires a license with Liebert MultiLink 1.5 Shutdown Client Software (see Table 12).

This section describes how to configure shutdown client computers so they may be selected for 
shutdown actions (see 12.2.4 - Configure Shutdown Actions). 

Before adding shutdown clients:

• MultiLink 1.5 Client software must be installed on all workstations and servers that require 
orderly shutdown.

• Make sure the MultiLink Shutdown license is installed on the Nform server (see 4.4.2 - Add a 
Liebert MultiLink 1.5 Shutdown License).

To configure shutdown clients:

• Start the Viewer with permission to manage shutdown clients (see 13.2 - Assigning Users to 
Groups).

• Click on the Configure menu, then choose Shutdown Clients.
• The Shutdown Clients window displays all configured clients. Options in this window include:

• Add to create a shutdown client: for details, refer to 11.1 - Add a Shutdown Client.
• Copy to create a new client based on the selected client.
• Edit to make changes to an existing client.
• Delete to remove a client from the list.

• Once any clients are configured, use the Test to send a test message to an existing client.
• Click to select a client from the list. Multiple selections are allowed using the standard 

shift-click and control-click methods.
• Click the Test button to send a test message to each selected client’s IP address or hostname. 
• A dialog box confirms whether the test message was sent. Also verify that each client 

computer received the message.

Test message sent

Test message NOT sent
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11.1 Add a Shutdown Client
To add a shutdown client:

1. Start the Viewer with permission to manage shutdown clients (see 13.2 - Assigning Users to 
Groups).

2. Click on the Configure menu, then choose Shutdown Clients.
3. In the Shutdown Clients window, click the Add button. This opens the Shutdown Client 

Properties window.

4. In the Name box, enter an identifying name for the client computer. This name will appear in lists 
of configured clients that can be selected for shutdown actions.

5. In the Description box, enter text to describe the client computer, if desired.
6. The Client Type box displays MultiLink v1.5. This cannot be changed.
7. In the Hostname or IP Address box, enter the client computer’s IP address or hostname, available 

from the System Administrator.
8. The IP Port designates the port used for communicating events (traps) with two options:

• Use standard port (162) 
• Use custom port (3029) 

The following table shows typical port combinations.

9. The default Trap Community is LiebertEM (case-sensitive). To change this, enter a new string.
10. Click OK. This saves the MultiLink Client device information.
11. Continue adding MultiLink 1.5 Client workstations, then proceed to 12.2.4 - Configure 

Shutdown Actions.

SNMP Trap Listen Port SNMP Send Request Port

Liebert MultiLink 3029 3027

Standard SNMP 162 161
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12.0 CONFIGURING ACTIONS

This section describes how to configure Liebert Nform to respond to events and alarms, such as:

• E-mail: sending e-mails to selected recipients when an alarm is received
• Run command: running an external program to protect data or equipment
• Write file: launching a command or batch file that can execute user-customized scripts
• Shutdown: configuring graceful shutdown of MultiLink client computers
• Forward trap: sending traps received to a specific computer (hostname or IP address)
• Read data: collecting samples of data points from selected managed devices
• Write data: changing values of selected data points based on specified alarms or events

Configuring actions enables Liebert Nform to protect valuable equipment, data and other assets from 
such events as power failures, overheating and mechanical failures.

12.1 Configuring Actions - Overview

Setting up actions involves three steps, as shown in the example below:

1. Create an action set—a named group of individual actions (see 12.2 - Configure an Action Set).
2. Add individual actions to the action set from a list: E-mail, Run command, Write file, Shutdown, 

Forward trap, Read data or Write data (see 12.2 - Configure an Action Set).
3. Link action sets to managed devices (see 12.3 - Map Action Sets to Devices and Alarms).

Action Set
1

Step 3
LINK ACTION 

SETS TO DEVICES

Step 2
ADD ACTIONS TO 

ACTION SETS

Step 1
CREATE 

ACTION SETS

Action Set
2

Action Set
3

E-mail (2)
Run command (3)

Write file (1)

E-mail (3)
Run command (1)

Shutdown (1)

Forward trap (1)
Read data (2)
Write data (1)

UPS
device

I/O
device

Other
device

Power
device

Precision cooling
device

Rack PDU
device

Battery monitoring
device

Diagram shows examples of possible configurations; 
any action sets can be linked to any configured devices.
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12.2 Configure an Action Set
To create an action set:

1. Start the Viewer with permission to configure at least one type of action (see 13.2 - Assigning 
Users to Groups).

2. Click on the Configure Actions icon at the bottom of the window (or click on the Configure 
menu, then choose Actions).

3. In the Action Sets window, click the Add button.

4. In the Name box, enter an identifying name for the action set. This name will appear in lists of 
action sets that can be assigned to events.

5. In the Description box, enter text to describe the action, if desired.
6. Click the Add button to create an action to include in this action set.
7. In the Select Action Type window, above right, click the type of action you wish to create: E-mail, 

Run command, Write file, Shutdown, Forward trap, Read data or Write data. 
8. Create individual actions to include in this action set, referring to the following sections:

• 12.2.1 - Configure E-Mail Actions for customized e-mail messages to selected recipients
• 12.2.2 - Configure Run Command Actions to launch scripts when alarms are received
• 12.2.3 - Configure Write File Actions to record alarm information in a file
• 12.2.4 - Configure Shutdown Actions for graceful shutdown of MultiLink client computers
• 12.2.5 - Configure Forward Trap Actions to send traps to a specific computer
• 12.2.6 - Configure Read Data Actions to collect samples of data points from a device
• 12.2.7 - Configure Write Data Actions to change values of selected data points based on 

specified alarms or events
9. Each time an action is added, the Action Set Properties window reappears and displays the new 

action. Items in the Actions list may be moved, changed or removed:
• To move an action up or down in the list, click on the name, then click the Up or Down arrow.
• To change an action’s properties, click on the name, then click the Edit button and make 

changes.
• To remove an action from the list, click on the name, then click the Delete button.

10. The Execute sequentially box in the Execution section specifies whether actions in this set will 
run in parallel (default, not checked) or sequentially in the order displayed in the Actions list. 
To choose the sequential method:

• Place a check mark  in the Execute sequentially box. 
• Specify what to do if an action fails during execution:

• To proceed executing all remaining actions after an action fails, place a check mark  in 
the Continue execution if an action fails box.

• To interrupt the execution and skip remaining actions, remove the check mark.
11. When finished, click the OK button.

Configure 
Actions
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12.2.1 Configure E-Mail Actions

To configure an E-Mail action to send an e-mail to selected recipients when an alarm is received:

1. Start the Viewer with permission to configure e-mail actions (see 13.2 - Assigning Users to 
Groups).

2. Open the E-Mail Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action—for example, UPS On Battery. This 

name will appear in lists of actions that can be assigned to events.
4. In the Description box, enter text to describe the action, if desired—for example, UPS On Battery.
5. In the To section, enter e-mail addresses of users to receive notifications:

a. Choose from a list of users by clicking the Select button to open the Nform Users Addresses 
window, below right. Select e-mail addresses from the list by placing check marks below the 
addresses you want to use—Pri. (Primary), Alt. (Alternate), SMS. Click OK.
Addresses are automatically updated for this action when changes are made to any user’s 
e-mail address (see 13.0 - Configuring Users and Groups).

b. Enter e-mail addresses in the Other recipients’ addresses box, separating each address 
with a semicolon (;) or press the Return key to make a new line.

c. Click the Send Test button to send a generic e-mail to verify that recipients are configured 
correctly to receive alarm notifications. The generic message is sent to all intended recipients 
with the word test in the subject and body. A separate error message appears for each attempt 
that is unsuccessful. Be sure to check that all e-mails are received.

6. In the Subject box, enter a subject for the e-mail by entering text or choosing fields from the drop-
down list to the right of the Subject box.

7. In the Message Body box, create a customized message for recipients by entering text or choosing 
fields from the drop-down list to the right of the Message Body box (see Table 5).
Table 5 Fields for e-mail messages

Field Description
Time received (UTC) The time when the alarm was received (universal time)
Time received (local) The time when the alarm was received (local time)
Occurred The elapsed time since the device was last initialized
Source Where the alarm occurred—e.g., device name or Nform
Device address The IP address or domain name of the device that sent the alarm
Alarm name The alarm name—for example, High Temperature or On-Battery
Alarm description The alarm description
Alarm severity The severity level of the alarm—for example, Critical
Alarm state The state of the alarm—Active or Cleared
Site Id A string supplied by Liebert Services to identify a group of devices
Device tag A string supplied by Liebert Services to identify a particular device

Send Test 
button

Select 
Nform users

Test message failed

Default 
Text
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SMTP Server
8. The SMTP Server is the outgoing mail server that will be used to send e-mail notifications. There 

are three ways to specify SMTP servers: 
a. Specify automatic selection of SMTP servers based on a recipient’s e-mail address. 

For this option, put a check mark  in the Automatically send to recipient’s server box. 
This option takes very little configuration and can be faster because e-mails are sent directly 
to each recipient’s SMTP server based on the domain name. 
The automatic option works properly only if an e-mail address is entered in the Sender’s 
Address in the SMTP Server window (see below and 8.4 - Server Options - SMTP Tab). 
This window is available from the Configure button in the E-Mail Action Properties window 
(below left) or the Configure menu as described in Section 8.4.
Use the Send Test button to verify the e-mail address is reachable (see Step 5a).
NOTE: If your network security software blocks e-mail sent using the automatic selection 
option, contact your network security administrator about whether the policy may be relaxed 
for your Nform server machine.

b. Specify a manually configured SMTP server. 
• To specify a manually configured server, choose that server from the drop-down list.
• To specify a server that has not yet been configured, click the Configure button to open the 

SMTP Server window (see below and 8.4 - Server Options - SMTP Tab). Configure the 
server and click OK, then choose that server from the drop-down list.

c. Specify BOTH automatic selection and a manually configured server. If you specify 
both and the automatic option fails, the manually configured server will be used as a backup.

9. The Timeout box displays the number of seconds to wait for a valid response if the action fails. 
The default is 5 seconds.

10. Click the Advanced button to open the E-Mail Action Advanced Properties window, above right.
• You may restrict the length of the message to a maximum number of characters in the Limit 

message to box; the default is 0, meaning no truncation. 
• Message encoding methods may be specified in the Subject encoding and Body encoding 

boxes. The default for both is Unicode (UTF-8). 
• Click OK to save any changes in the E-Mail Action Advanced Properties window.

11. Click OK to save any changes in the E-Mail Action Properties window.

SMTP Server window

Sender’s Address
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12.2.2 Configure Run Command Actions

To configure a Run Command action to launch a script when an alarm is received:

1. Start the Viewer with permission to configure run command actions (see 13.2 - Assigning Users 
to Groups).

2. Open the Run Command Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action. This will appear in lists of actions that 

can be assigned to events.
4. In the Description box, enter text to describe the action, if desired.

5. In the File box, enter the full path of the program to be initiated—either type the full path or use 
the Browse button to locate the file. (The Browse button appears only when using the Viewer on 
the application server where the full Nform package is installed; see 2.1 - Installation.)

6. In the Command-Line Arguments box, specify arguments—parameters to include in running the 
command—by entering text or choosing fields from the drop-down list to the right of the 
Command-Line Arguments box (see Table 6). These fields will be appended to the Run command 
line.

7. The Timeout box displays the number of seconds to wait for a valid response if the action fails. 
The default is 5 seconds.

8. Click OK to save any changes.

Table 6 Fields for command-line arguments

Field Description

Time received (UTC) The time when the alarm was received (universal time)

Time received (local) The time when the alarm was received (local time)

Occurred The elapsed time since the device was last initialized

Source Where the alarm occurred—e.g., device name or Nform

Device address The IP address or domain name of the device that sent the alarm

Alarm name The alarm name—for example, High Temperature or On-Battery

Alarm description The alarm description

Alarm severity The severity level of the alarm—for example, Critical

Alarm state The state of the alarm—Active or Cleared

Site Id A string supplied by Liebert Services to identify a group of devices

Device tag A string supplied by Liebert Services to identify a particular device
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12.2.3 Configure Write File Actions

To configure a Write File action to record alarm information in a file:

1. Start the Viewer with permission to configure write file actions (see 13.2 - Assigning Users to 
Groups).

2. Open the Write File Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action—for example, Critical Alarms. This 

will appear in lists of actions that can be assigned to events.
4. In the Description box, enter text to describe the action, if desired.

5. In the File box, enter the full path of the file that will record details of events or use the Browse 
button to locate the file. (The Browse button appears only when using the Viewer on the 
application server where the full Nform package is installed; see 2.1 - Installation.) If the file 
does not exist, Liebert Nform will create it.

6. In the Record format box, choose fields to include in the file from the drop-down list to the right 
of the Record format box (see Table 7). 

7. Enter the upper limit of the file size in MB in the Maximum size box. The default is 1 MB.
8. In the File Open Mode section:

• Click Append to existing file to add data at the end of the file, preventing existing data 
from being overwritten by new information. 

• Click Create new file to replace the file with each new alarm.
9. An encoding method may be specified in the File encoding box. The default is Unicode (UTF-8).
10. The Timeout box displays the number of seconds to wait for a valid response if the action fails. 

The default is 5 seconds.
11. Click OK to save any changes.

Table 7 Fields for record format

Field Description

Time received (UTC) The time when the alarm was received (universal time)

Time received (local) The time when the alarm was received (local time)

Occurred The elapsed time since the device was last initialized

Source Where the alarm occurred—e.g., device name or Nform

Device address The IP address or domain name of the device that sent the alarm

Alarm name The alarm name—for example, High Temperature or On-Battery

Alarm description The alarm description

Alarm severity The severity level of the alarm—for example, Critical

Alarm state The state of the alarm—Active or Cleared

Site Id A string supplied by Liebert Services to identify a group of devices

Device tag A string supplied by Liebert Services to identify a particular device
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12.2.4 Configure Shutdown Actions

This feature requires a license with Liebert MultiLink 1.5 Shutdown Client Software (see Table 12).

To configure a Shutdown action for client computers with MultiLink 1.5 installed:

1. Start the Viewer with permission to configure shutdown actions (see 13.2 - Assigning Users to 
Groups).

2. Open the Shutdown Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action—for example, Shutdown EDI 

application server. This will appear in lists of actions that can be assigned to events.
4. In the Description box, enter text to describe the action, if desired.

5. In the Shutdown Type box, click on the appropriate choice:
• Immediate shutdown - the shutdown will occur as soon as a specified condition occurs.
• Timed shutdown - a timer will begin as soon as a specified condition occurs.
• Cancel pending shutdown - when a specified condition occurs, stop a shutdown that is in 

progress.
6. In the Shutdown Client Selection area:

• Enter any client computers with MultiLink 1.5 installed that may be specified for shutdown. 
If needed, click the Configure button to set up or choose client computers.

• Place a check mark  to the left of any items you wish to select. If desired, click Select All to 
choose all items in the list or click Clear All to remove all check marks.

7. The Timeout box displays the number of seconds to wait for a valid response if the action fails. 
The default is 5 seconds.

8. Click OK to save any changes.
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12.2.5 Configure Forward Trap Actions

The Forward Trap action may be used to forward individual traps to multiple destinations. 

This differs from the global Trap Forwarding setting, which may be used to send all selected types of 
traps collected by Liebert Nform to a specified computer (see 8.7 - Server Options - Trap 
Forwarding Tab).

To configure a Forward Trap action to send traps to one or more computers:

1. Start the Viewer with permission to configure forward trap actions (see 13.2 - Assigning Users 
to Groups).

2. Open the Forward Trap Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action—for example, Forward Traps to 

IT Manager. This will appear in lists of actions that can be assigned to events.
4. In the Description box, enter text to describe the action, if desired.

5. In the Trap Recipients area:
• Specify the computer where traps should be forwarded in the Hostname or IP address column. 
• The Port Number displays the default global setting—typically, 162. To change this, enter a 

different number.
6. The Timeout box displays the number of seconds to wait for a valid response if the action fails. 

The default is 5 seconds.
7. Click OK to save any changes.
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12.2.6 Configure Read Data Actions

This feature requires a license with Advanced Communications (see Table 12).

The Read Data action may be used to collect real-time data after being triggered by an event. 

This event-based feature differs from the time-based Data Logging feature, which may be used to 
collect real-time data continuously at fixed intervals to track the condition of a device (see 9.2.7 - 
Data Logging). 

Both features collect the same type of data, which may be viewed in a trend graph (see 16.3.4 - 
Navigate - Trends View) or exported to a text file (see 14.3 - Export Data Log History).

To configure a Read Data action to collect samples of data points from a device:

1. Start the Viewer with permission to configure read data actions (see 13.2 - Assigning Users to 
Groups).

2. Open the Read Data Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action—for example, Read Data Action 1. This 

name will appear in lists of actions that can be assigned to events.
4. In the Description box, enter text to describe the action, if desired.

5. Choose a device from the Managed Devices list.
6. The available data points for the selected device appear in the window below the device name, 

along with units where appropriate. Click on a data point to display an explanation in the 
Description box below the list.

7. Click to place a check mark  to the left of each data point you wish to select. Each checked point 
appears in the Selected Data Points in the right side of the window.

8. The default Duration of reading data points is 5 minutes. If desired, choose a different number of 
minutes.

9. The default Sampling Interval is 30 seconds. If desired, choose a different number of seconds.
10. Click OK to save any changes.

Select 
device
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12.2.7 Configure Write Data Actions

To configure a Write Data action to change values of selected data points based on specified alarms or 
events:

1. Start the Viewer with permission to configure write data actions (see 13.2 - Assigning Users to 
Groups).

2. Open the Write Data Action Properties window (see 12.2 - Configure an Action Set).
3. In the Name box, enter an identifying name for the action—for example, Write Data Action 1. This 

name will appear in lists of actions that can be assigned to events.
4. In the Description box, enter text to describe the action, if desired.

5. Choose a device from the Managed Devices list. 
6. The available data points for the selected device appear in the window below the device name, 

along with units where appropriate. Click on a data point to display an explanation in the 
Description box below the list.

7. Click to place a check mark  to the left of each data point you wish to select. Each checked point 
appears in the Selected Data Points in the right side of the window.

8. If desired, repeat Steps 5 through 7 to choose another device from the Managed Devices list and 
select data points for that device.
The Selected Data Points list at right displays the device name for each data point.

9. For each point in the Selected Data Points at right, enter a figure in the New Value column to 
specify the value you wish to write based on a specified condition.

10. The Timeout box displays the number of seconds to wait for a valid response if the action fails. 
The default is 5 seconds.

11. Click OK to save any changes.
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12.3 Map Action Sets to Devices and Alarms

The final step in configuring actions is to define which alarms will trigger an action set to be executed 
for which devices. Mapping an action set requires permission to configure all actions in that set. 
Actions will not be executed for alarms from a device that is currently in maintenance mode.

To map an action set:

1. Start the Viewer with permission to assign actions (see 13.2 - Assigning Users to Groups).
2. Click on the Configure Actions icon at the bottom of the window (or click on the Configure 

menu, then choose Actions).
3. In the Action Sets window, click on an action set, then click the Map button.

4. In the Map Actions window:
• All devices are displayed in the left side of the window. If desired, choose a device category—

e.g., UPS—from the drop-down list to display only those devices.
• Click on a device at left to display all applicable alarms in the right side of the window. Click 

a second time to deselect a device. (To select multiple devices, use the standard shift-click or 
control-click methods.)

• In the right side of the window, click to select an alarm that will trigger the selected action set 
for the selected devices. Click a second time to deselect an alarm. (To select multiple alarms, 
use the standard shift-click or control-click methods.)

• Click the Assign button to assign all selected alarms to the selected devices. (To remove 
alarms from the mapping, click to select the alarms, then click the Clear button.)

5. Mapping status is indicated by:
• A bullet next to a device in the Managed Devices tree at left indicates at least one alarm 

has been mapped to that device for the selected action set.
• In the Device Alarms grid at right (with one or more devices highlighted for a selected action 

set):
Box is: Alarm is mapped to:

Filled All selected devices for the action set.

Half-filled At least one selected device for the action set.

Empty None of selected devices for the action set.

Configure 
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13.0 CONFIGURING USERS AND GROUPS

The software automatically creates an Administrator account with full access to configuration and 
monitoring. 

Other individual users may be configured with any combination of viewing and configuration 
privileges (see 13.1 - Add Individual Users). A user may be created with the Add button or based 
on an existing user with the Copy button.

Additionally, individual users may be combined into groups with similar privileges (see 13.2 - 
Assigning Users to Groups).

This feature speeds up the process of assigning privileges to many users and allows for easily 
selecting many users for actions, such as receiving e-mail alerts.
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13.1 Add Individual Users
1. Start the Viewer with permission to configure users (see 13.2 - Assigning Users to Groups).
2. Click on the Configure Users & Groups icon at the bottom of the window (or click on the 

Configure menu, then choose Actions).
3. The Users list displays all configured users. Click the Add button to the right of the Users list.

4. In the User Properties window, enter a user name—the name used for login—in the Name box.
5. In the Full Name box, enter the person’s name or title to help identify the user, if desired.
6. In the Description box, enter text to describe the user, if desired.
7. Enter a password in the Password box, then re-enter it in the Confirm Password box.

The password is case-sensitive and must consist of two to 14 characters—with any combination of 
letters, numerals and symbols. Be sure to record the password in a secure place.

8. Enter this information about the user for Liebert Nform alerts and notifications:
• Pri. e-mail - primary e-mail address
• Alt. e-mail - alternate e-mail address
• SMS e-mail - text message e-mail address
• Phone - telephone number, including area code
• Mobile - cell phone number, including area code

9. If user groups have been created, choose from the Group list to assign the user to a group.
10. Specify the opening view in the Navigate tab for this user by selecting from the Nav. view drop-

down list. The default is All Devices. See 10.0 - Configuring Views for the Navigate Tab.
11. Specify whether to activate these features with a check mark :

• User must change password at next login - allow users to select their own passwords
• User cannot change password - prevent users from changing passwords
• Account is disabled - deactivate a user account without deleting it
• User cannot change alerts - prevent users from access to the Visual alerts and Audible 

alerts tabs in the User Options window
• Auto-logout user after: ___ min - automatically log the user off after no activity; if checked, 

specify the number of minutes in the Min. drop-down list
12. Click the User Options button for additional features (see 7.0 - Configuring User Options).
13. When finished, click the OK button to save any changes.

Configure 
Users & 
Groups
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13.2 Assigning Users to Groups

Groups are used to assign permissions to users. Individual users must be assigned to groups that 
have specific permissions. This function may also be used to map users to actions such as e-mail 
alerts. Changes in this section apply to all users in the group.

To create a group of users:

1. Start the Viewer with permission to configure groups (see Step 3 below).
2. Click on the Configure Users & Groups icon at the bottom of the window (or click on the 

Configure menu, then choose Actions).
3. The Groups list in the lower portion of the window displays all user groups. Click the Add button 

to the right of the Groups list.

4. In the Group Properties window, enter a name for the group in the Name box.
5. In the Description box, enter text to describe the group, if desired.

Configure 
Users & 
Groups
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6. Select privileges by placing a check mark  in the box, referring to the table below. Privileges are 
logically grouped according to function, but each privilege may be assigned separately.

7. When finished, click OK to save any changes.

Table 8 Summary of group privileges

Category Privilege For details, see:

Manage 
Users

Configure users 13.1 - Add Individual Users

Configure groups 13.2 - Assigning Users to Groups (this section)

Manage 
Devices

Configure devices 9.1 - Add Devices to the Configuration

Set device data 16.3.2 - Navigate - Parametrics View (Edit option)

Configure navigation views

10.0 - Configuring Views for the Navigate Tab, including:
• 10.1 - Add or Edit Views
• 10.2 - Add or Edit an Area
• 10.3 - Place Devices in Floor Plans
• 10.4 - Create Logical Groups 

Discover new devices1 9.1.2 - Detect Devices on a Network

Configure data logging1,2 9.2.7 - Data Logging

Edit device definitions1
9.2.6 - Alarms and Data (both tabs):
• Alarms and Data - Alarms Tab
• Alarms and Data - Data Tab

Manage 
Alarms Acknowledge and close alarms

16.3.3 - Navigate - Alarms View
16.4.2 - Managing Alarms

Manage 
Actions

Assign actions 12.3 - Map Action Sets to Devices and Alarms

Configure 
Actions

E-mail 12.2.1 - Configure E-Mail Actions

Run command 12.2.2 - Configure Run Command Actions

Write file 12.2.3 - Configure Write File Actions

Shutdown4 12.2.4 - Configure Shutdown Actions

Forward trap3 12.2.5 - Configure Forward Trap Actions

Read data 12.2.6 - Configure Read Data Actions

Write data 12.2.7 - Configure Write Data Actions

Manage 
System

Server parameters
8.1 - Server Options - General Tab (Locale)
8.3 - Server Options - Alarms Tab
8.5 - Server Options - Device Tab (Emerson Protocol)

Licenses 4.4.1 - Add a Liebert Nform License Key
4.4.2 - Add a Liebert MultiLink 1.5 Shutdown License

Global device parameters 8.5 - Server Options - Device Tab (Global status polling)
8.6 - Server Options - SNMP Tab

Email parameters 8.4 - Server Options - SMTP Tab

Start/stop server
18.3.1 - Application Menu - Service
18.5.1 - Tools Menu - Install DTD

Logging parameters
8.1 - Server Options - General Tab (Audit log file)
8.2 - Server Options - Event Log Tab
8.5 - Server Options - Device Tab (Data logging storage2)

SNMP trap forwarding3 8.7 - Server Options - Trap Forwarding Tab

Shutdown clients4 11.0 - Configuring Shutdown Clients

NOTES:
1. Selecting this option automatically gives permission to configure devices (Configure devices box is checked & disabled).
2. Requires a license with Advanced Communications (see Table 12).
3. Requires a license with Advanced Notifications (see Table 12).
4. Requires a shutdown client license (see Table 12).
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14.0 USING THE TOOLS MENU

The Tools menu offers options to export data to text files that may be opened with any text editor or 
spreadsheet program.

14.1 Export Alarm History

The Alarm History log may be exported as a text file that can be viewed or edited with a text editor or 
spreadsheet program. You may specify the type of alarm, the time period and the type of text file.

1. Start the Viewer. 
2. Click on the Tools menu, choose Export and then choose Alarm History to open the Export 

Alarm History window.

3. Specify which category of alarms to export in the Alarm Type area:
• Device alarms - export alarms for selected devices only—for example, UPS on battery
• Application alarms - export program-related alarms only—for example, Service started
• All alarms - export both types of alarms (device and application) for all devices

4. (Only if Device alarms is selected:) Place a check mark  to the left of each device to include or:
• Click Select all to choose all devices.
• Click Clear all to remove all check marks.

5. The default Start Date and End Date for the exported file include all records, ranging from the 
oldest alarm in the database to the latest, or most recent. 
To change a date, click Start from alarm with specified date or End with specified date 
and choose a date from the calendar below the button.

6. In the Separator box, choose the type of character to use between fields in the exported file: 
comma (,) (the default), semicolon (;) or tilde (~).

7. The File box displays the default location—Nform\user\export—for the exported file. The file 
name includes the date and time with the extension .csv. 
To change this, enter the full path in the File box or click Change to browse for the location.

8. Click OK to export the file. A message window appears after the process is complete. 
The exported text file has headings in the first row, as in the following example.

AlarmRecvDttm, MgdDeviceName, MgdDeviceAddress, AlarmId, AlarmName, AlarmSev, AlarmStatus, AckDttm, AckUsrName, 
ClosedDttm, ClosedUsrName, Incident

2008-07-07 08:44:14, Nform, , 12, Service started,Info,Unacknowledged,, ,, , , 

2008-07-07 08:44:36, Nform, , 13, Device monitoring started,Info,Unacknowledged,, ,, , , 

2008-07-07 08:44:40, UPS_192.168.0.11, 192.168.0.11, 15, No Alarms Present,Info,Unacknowledged,, ,, , , 

2008-07-07 08:44:53, UPS_192.168.0.125, 192.168.0.125, 16, Communications Lost,Critical,Unacknowledged,, ,, , , 
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14.2 Export Action History

The Action History log may be exported as a text file that can be viewed or edited with a text editor or 
spreadsheet program. You may specify the type of alarm that triggered any action, the time period 
and the type of text file.

1. Start the Viewer. 
2. Click on the Tools menu, choose Export and then choose Action History to open the Export 

Action History window.

3. Specify which category of alarms that triggered any action to export in the Alarm Type area:
• Device alarms - export alarms for selected devices only—for example, UPS on battery
• Application alarms - export program-related alarms only—for example, Service started
• All alarms - export both types of alarms (device and application) for all devices

4. (Only if Device alarms is selected:) Place a check mark  to the left of each device to include or:
• Click Select all to choose all devices.
• Click Clear all to remove all check marks.

5. The default Start Date and End Date for the exported file include all records, ranging from the 
oldest action in the database to the latest, or most recent. 
To change a date, click Start from action with specified date or End with specified date 
and choose a date from the calendar below the button.

6. In the Separator box, choose the type of character to use between fields in the exported file: 
comma (,) (the default), semicolon (;) or tilde (~).

7. The File box displays the default location—Nform\user\export—for the exported file. The file 
name includes the date and time with the extension .csv. 
To change this, enter the full path in the File box or click Change to browse for the location.

8. Click OK to export the file. A message window appears after the process is complete. 
The exported text file has headings in the first row, as in the following example.

AlarmRecvDttm, MgdDeviceName, MgdDeviceAddress, AlarmId, AlarmName, AlarmSev, AlarmStatus, AckDttm, AckUsrName, 
ClosedDttm, ClosedUsrName, Incident

2008-07-11 12:34:13, Nform, , 1, Service started,Info,Closed,2008-07-14 00:30:18, System,2008-07-14 00:30:18, System, , 

2008-07-11 12:43:39, Precision Cooling_192.168.203.234, 192.168.203.234, 6, Communications Restored,Info,Closed,2008-07-14 
00:37:31, System,2008-07-14 00:37:31, System, , 

2008-07-15 13:21:13, UPS_192.168.202.191, 192.168.202.191, 2024, Communications Lost,Critical,Closed,2008-07-15 15:50:38, 
System,2008-07-15 15:50:38, System, , 

2008-07-15 13:22:02, UPS_192.168.200.127, 192.168.200.127, 2025, upsTrapOnBattery,Warning,Closed,2008-07-15 15:51:03, 
System,2008-07-15 15:51:03, System, , 
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14.3 Export Data Log History

The Data Log History may be exported as a text file that can be viewed or edited with a text editor or 
spreadsheet program. You may export all records (the default) or select a time period and particular 
logged data points. You may also choose a comma-delimited (default) or other type of text file.

1. Start the Viewer. This feature requires logged data 
via Data Logging or the Read Data action (see 
9.2.7 - Data Logging and 12.2.6 - Configure 
Read Data Actions). Data logging requires a 
license with Advanced Communications (see 
Table 12).

2. Click on the Tools menu, choose Export and then 
choose Data Log History to open the Export Data 
Log window.

3. Click Next.
4. Place a check mark  to the left of each device to 

include or:
• Click Select all to choose all devices.
• Click Clear all to remove all check marks.

5. The default Start Date and End Date for the 
exported file include all records, ranging from the 
oldest to the latest. 
To change a date, click Start from records with 
specified date or End with specified date 
record and choose a date from the calendar below 
the button.

6. Click Next.
7. The list will contain data points that are currently 

being logged. Place a check mark  to the left of 
each data point to include or:

• Click Select all to choose all data points.
• Click Clear all to remove all check marks.
• Place a check mark  in Export all logged 

data points to include those that were 
previously logged but are not currently being 
logged.

8. Click Next.
9. In the Separator box, choose the type of character to 

use between fields in the exported file: comma (,) 
(the default), semicolon (;) or tilde (~).

10. The File box displays the default location—
Nform\user\export—for the exported file. The 
file name includes the date and time with the 
extension .csv. 
To change this, enter the full path in the File box or 
click Change to browse for the location.

11. Click Next to export the file.
12. A message in the next window reports whether the 

exporting was successful. Click Finish to return to 
the Viewer. 
The exported text file has headings in the first row, 
as in the following example.

RecvDttm, LoggingResult, LoggingStatus, MgdDeviceName, ModuleName, DataPointName, DataValue, DataUnits
2008-07-07 08:46:19, Success, 0, UPS_192.168.0.11, , upsSecondsOnBattery, 0, sec, 
2008-07-07 08:46:19, Success, 0, UPS_192.168.0.11, , upsEstimatedMinutesRemaining, 126, min, 
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15.0 USING THE HELP MENU

The Help menu lets you open Liebert Nform help to the Contents or Index tab, view a list of device 
types supported by Liebert Nform, open Liebert Nform help to access technical support contact 
information, check for updates to the Nform application or supported devices (DTD) and view details 
about Liebert Nform.

15.1 Contents

Use this option to open Liebert Nform help to the Contents tab.

To do this:

• Start the Viewer.

• Click on the Help menu at the top of the window, then click on Contents. The NformHelp 
window opens with the Contents tab selected
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15.2 Index

Use this option to open Liebert Nform help to the Index tab.

To do this:

• Start the Viewer.

• Click on the Help menu at the top of the window, then click on Index. The NformHelp window 
opens with the Index tab selected.
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15.3 Supported Device Types

Use this option to view a list of device types supported by the Nform software.

To do this:

• Start the Viewer.

• Click on the Help menu at the top of the window, then click on Supported Device Types. The 
Supported Device Types window displays a list of devices along with the Category icon and name 
and the Protocol, as shown below.
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15.4 Technical Support

Use this option to open Liebert Nform help to display contact information for technical support.

To do this:

• Start the Viewer.

• Click on the Help menu at the top of the window, then click on Technical Support. The 
NformHelp window opens to the section with contact information for tech support.
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15.5 Check for Updates

You may check manually for updates to the Liebert Nform software and device support (DTD) files at 
any time. See 8.8 - Server Options - Updates Tab to have this done automatically.

To check for updates manually:

• Start the Viewer with permission to manage licenses (see 13.2 - Assigning Users to Groups).

• Click on the Help menu at the top of the window, then click on Check for Updates. (If no 
updates are available, a notification window appears, as shown below.)

• The Updates Available window displays all updates that may be installed. The example below 
shows the three types—DTD (an updated device support file), Patch (a software patch) and 
Product (a software update)—along with a description, the filename and whether the file has been 
downloaded. (The Download Directory appears only if the Viewer is running on the Nform server.)

The Updates Available button shown below appears in the Viewer when updates are available. 
Clicking on this button opens the Updates Available window above.

To download updates manually, go to the Software Assurance Web site (see Table 1).
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15.6 About Liebert Nform

View details on Nform Viewer version, server, database, installed license keys, registration and how 
to contact technical support.

To do this:

• Start the Viewer.

• Click on the Help menu at the top of the window, then click on About Liebert Nform.
• Click on any tab—Viewer, Server, Database, License or Registration—to view the appropriate 

information. The example below shows the License tab with details about all license keys that 
are installed. All tabs display the same contact information in the Support section in the bottom 
half of the window. 

• Click OK to close the window.
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16.0 OPERATION - USING THE VIEWER

The Viewer has three tabs that offer different views of managed devices and monitored device data, 
described in the following sections:

• 16.1 - Dashboard Tab - quick graphical look at the current status of managed devices
• 16.2 - Navigate Tab - Area - hierarchical view of configured areas, with detailed data
• 16.3 - Navigate Tab - Device - hierarchical view of managed devices, with detailed data
• 16.4 - Alarms Tab - view and management of alarm data

16.1 Dashboard Tab

The Dashboard tab is active when the Viewer is launched, providing a quick summary of the status of 
monitored and managed devices. For features available in the Dashboard view, refer to:

• 16.1.1 - Dashboard View - overview of the Dashboard window
• 16.1.2 - Select Devices for Gadgets - use status buttons and filters to select devices
• 16.1.3 - Customize Gadgets - limit devices shown, change graph type and colors
• 16.1.4 - Add Gadgets - create a new gadget
• 16.1.5 - Global Gadget Options - additional options to change the appearance of any pie chart

16.1.1 Dashboard View
The Dashboard tab is the default view when the Viewer is opened.

• Click on the Dashboard tab to display gadgets in the Viewer Display Area. The gadgets show 
device status data in graph or list form. 

• Default gadgets appear after installation (see 16.1.4 - Add Gadgets to add gadgets):
• Device Status - list of managed devices by status: No communication, Normal or Alarm
• Alarm Status - 3D graph of managed devices currently in alarm
• Alarm Severity - 3D graph of managed devices by level of alarm severity

Resize and Rearrange Gadgets
Gadgets may be resized and rearranged:

• Resize a gadget using the standard Windows buttons in the upper right corner—Minimize, 
Maximize and Restore—or move it by clicking on the title bar and dragging it.

• If the Close button is clicked, the gadget disappears permanently. To create a new gadget, see 
16.1.4 - Add Gadgets.

• Right-click on any gadget, then choose Tile or Cascade to rearrange all gadgets.

Gadgets

Minimize, 
Maximize/Restore

DEFAULT VIEW 
All devices shown 
in gadgets
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16.1.2 Select Devices for Gadgets

Status buttons and filters offer a quick way to select which devices to show in gadgets.

Use Status Buttons to Show Device Status View

A status button may be used to toggle between a list of devices with that status and the default view:

• Click on a status button—the example below shows No communication. The button has a gray 
outline, the name of the selected state appears above the Viewer Display Area and gadgets in the 
display area show only devices in that state. 

• Each device status view—No communication, Normal and Alarm—has a Device Status list gadget 
by default. Customized gadgets may be added to any view and will be pre-filtered with devices in 
the selected state. Device status views operate independently.

• When the status button has a gray outline, click again to restore the default view showing all 
devices and all gadgets. Toggle between views with any of the three status buttons.

Apply Filters

A filter may be applied in any gadget to show only devices that meet the specified criteria:

• Enter criteria in the Filter box at the bottom of the window—the example below shows a different 
filter for each window: MPX, Nform and 114. The text must appear in the device name, 
description, IP address or status.

• Press the Enter key. The gadget shows all devices that meet the criteria.
• Hover the mouse over a pie segment to reveal the number and percentage of devices in the chart.
• To remove the filter and show all devices, simply delete the text in the Filter box and press Enter.

Device Status
gadget shows only 
devices in selected 
status category 
(No communication)

Status button 
selected 
(gray outline)

DEVICE STATUS VIEW 
Status button selected 
to show only devices 
in that state

Name of selected state
No communication

Filter 
for this 
gadget

Show data for 
segment on 
mouseover

FILTERED VIEW
Filters applied in 
gadget windows
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16.1.3 Customize Gadgets

Each gadget may be customized to limit the number of devices shown, change the type of graph and 
choose different colors for the graph categories. Also see 16.1.5 - Global Gadget Options for 
additional sizing and label options for pie charts.

To customize a gadget:

• Click on Setup in the bottom right corner of any gadget to open an Edit window. 

• At the top of the Edit window, choose groups of devices to display in this type of graph (the default 
is All devices):

• Device category—for example, UPS
• Device type—for example, Liebert GXT UPS/Web Card
• Manufacturer—for example, Liebert

• In the Specific Device section, choose a single device to display in the graph (the default is All):
• To choose a device by IP address, click Show addresses, then select from the drop-down list.
• To choose a device by name, click Show names, then select from the list.

• In the Display Type list, choose the type of graph for this gadget:
• 3D Pie Chart - three-dimensional circle graph (default)
• 2D Pie Chart - two-dimensional circle graph
• List - color-coded text listing of alarms or devices in each category

• In the Slice Colors list, click on a category—for example, Normal or Unacknowledged—then click 
on the color box to change the color representing that category.

• In the Color window, choose a color from the Basic colors list at the top (or click on the Define 
Custom Colors button to select a different color—see 7.2 - User Options - General Tab). The 
selected color is outlined. Click OK to close the Color window.

• Click the Reset to Global button to apply global options to this gadget (see 16.1.5 - Global 
Gadget Options). This button is disabled if no gadget properties have been customized.

• Click Apply at any time to view the changes without closing the Edit window.
• When finished, click OK to save changes (or Cancel to close without saving).

Reset to 
Global 
button

Setup
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16.1.4 Add Gadgets

Besides the three default gadgets, additional gadgets may be created. This feature permits separate 
gadgets showing the status of UPSs and cooling units, for example.

To create a gadget:

• Click on the Alarms or Communication button directly below the Dashboard tab to open an 
Add window.

• In the Add window, select the options for the new gadget (see 16.1.3 - Customize Gadgets).
• When finished, click OK.
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16.1.5 Global Gadget Options

The pie chart size and labels may be customized in any gadget. To do this:

• Click on Global Options in the right side of the window—with the Dashboard tab selected—to 
open the Configure Global Gadget Display window.

• Click on the tab for the gadget to be changed:
• To change the Device Status pie chart, click the Communication tab.
• To change the Alarm Status pie chart, click the Alarms tab, then the Alarm Status tab.
• To change the Alarm Severity pie chart, click the Alarms tab, then the Alarm Severity tab.

• For each category:
• Click the Slice color box to change the color (see 16.1.3 - Customize Gadgets).
• Valid Offset values range from 0 to 1 (default offset is 0.05 for each slice, 0.25 for pie height).

• Place a check mark  for each additional option to be activated:
• Fit chart - cause the graph to fill the gadget regardless of window size.
• Turn labels on (checked by default) - show the Slice Name for each category on the graph
• Show zero slice - show a label for any slice representing a category with no devices or 

alarms (if Turn labels on is also checked)
• Click Apply at any time to view the changes without closing the Edit window.
• When finished, click OK to save changes (or Cancel to close without saving).
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16.2 Navigate Tab - Area

The Navigate tab displays managed devices and floor plans in a navigation tree in the left side of the 
window. Tabs in the right side of the window offer options to display various types of data for a 
selected area or device.

The tabs vary, depending on whether an area or a device is selected in the left side of the window. The 
options for a selected area are:

• 16.2.1 - Navigate - Floor Plan View - display of placement of devices in the selected area
• 16.2.2 - Navigate - Alarms View - listing of alarms for the selected area
• 16.2.3 - Navigate - Info Links View - clickable links to relevant Web pages or computer files

The default navigation view—All Devices—shows every device that has been added to the Managed 
Devices list (see 9.1 - Add Devices to the Configuration). 

Customized views may be created for any reason and may be specified as the opening view for any 
user (see 10.0 - Configuring Views for the Navigate Tab).

The arrow tab indicates that double-clicking opens the Navigate view in a separate window, which 
can be dragged anywhere on the screen or to another monitor. The Navigate tab disappears from the 
original window as long as the separate window remains open.

16.2.1 Navigate - Floor Plan View
• Click on the Navigate tab, then click on an area in the tree at left. 
• In the right side of the window, click on the Floor Plan tab to display the area’s floor plan 

showing configured placement of devices in the selected area. Icons indicate the status of any 
devices that have been configured in the floor plan (see Table 9).
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16.2.2 Navigate - Alarms View

The Alarms view in the Navigate tab displays alarm history data for a selected area. Authorized users 
may acknowledge and close alarms and add comments and incident reports to any alarm from this 
window. 

This window offers the same alarm features as the Alarms tab (see 16.4 - Alarms Tab). The Alarms 
view described in this section shows alarms for all devices that are part of the selected area.

To view this data:

• Click on the Navigate tab, then click on an area in the tree at left—the example below shows the 
All Devices area selected.. 

• In the right side of the window, click on the Alarms tab to display alarm history data for the 
selected area in the Viewer Display Area. The alarm list shows details about the time of 
occurrence, type of alarm, source of the alarm, its severity and any comments or incidents. (If an 
alarm was received during a scheduled maintenance and a Reason was specified, that text 
appears in the Incident column.)

• Click on an alarm in the list, then click on any of the following buttons above the alarm list for 
additional options, which are available to users with permission to manage alarms (see 13.2 - 
Assigning Users to Groups):

• Acknowledge - to acknowledge the selected alarm.
• Close - to remove the selected alarm from the display.
• Details - to view or add comments, incident reports and other alarm information in the Alarm 

Details window (see 16.4 - Alarms Tab for more information).
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16.2.3 Navigate - Info Links View

The Info Links tab displays information links for a selected area. These are user-defined links to Web 
page or files that pertain to this area.

To view this data:

• Click on the Navigate tab, then click on an area in the tree at left. 
• In the right side of the window, click on the Info Links tab to display configured links for the 

selected area in the Viewer Display Area.

• User-defined info links are configured by users. For details on adding, editing or deleting these 
links, refer to:

• 9.2.5 - Info Links for details on adding or changing an info link
• 10.2 - Add or Edit an Area to add an info link for an area
• 10.4.1 - Group Properties - Logical Groups to add an info link for a logical group
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16.3 Navigate Tab - Device

The Navigate tab displays managed devices and floor plans in a navigation tree in the left side of the 
window. Tabs in the right side of the window offer options to display various types of data for a 
selected area or device.

The tabs vary, depending on whether an area or a device is selected in the left side of the window. The 
options for a device are:

• 16.3.1 - Navigate - Web View - access to the device using a Web browser interface
• 16.3.2 - Navigate - Parametrics View - tabular display of parametric data for the device
• 16.3.3 - Navigate - Alarms View - listing of alarms for the selected device
• 16.3.4 - Navigate - Trends View - graph of data points collected through data logging
• 16.3.5 - Navigate - Info Links View - clickable links to relevant Web pages or computer files

The default navigation view—All Devices—shows every device that has been added to the Managed 
Devices list (see 9.1 - Add Devices to the Configuration). 

Customized views may be created for any reason and may be specified as the opening view for any 
user (see 10.0 - Configuring Views for the Navigate Tab).

The arrow tab indicates that double-clicking opens the Navigate view in a separate window, which 
can be dragged anywhere on the screen or to another monitor. The Navigate tab disappears from the 
original window as long as the separate window remains open.

16.3.1 Navigate - Web View
• Click on the Navigate tab, then click on a device in the tree at left. 
• In the right side of the window, click on the Web tab to display the device’s data in a Web browser 

view. A message appears if the device does not have a Web card or if communication has been lost.

• To view the same device data in the computer’s default Web browser, click View in browser. The 
Web browser opens and connects to the device’s IP address.
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16.3.2 Navigate - Parametrics View

The Parametrics tab displays parametric data for the selected device.

To view this data:

• Click on the Navigate tab, then click on a device in the tree at left. 
• In the right side of the window, click on the Parametrics tab to display parametric data for the 

selected device in the Viewer Display Area.

• Two types of parametric data are available. Click on one of these options to display device data or 
statistics for the device.

• Data - the default, shown above left
• Statistics - options depend on the device selected—SNMP in the example above right

• To sort the list, click on a column heading—for example, Name.
• Click these tabs above the list for additional options:

• Details - open a window that displays a definition of the selected item. Click on Close to 
return to the Parametrics view.

• Refresh - update the display with the most current device information.
• Edit - make changes to the device itself—available only to users with permission to set device 

data (see 13.2 - Assigning Users to Groups). 
When Edit mode is active, this tab toggles to Read only - leave Edit mode and return to 
display-only mode (see 9.2.6 - Alarms and Data for more information).

Data 
selected

Statistics/SNMP 
selected
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16.3.3 Navigate - Alarms View

The Alarms view in the Navigate tab displays alarm history data for a selected device. Authorized 
users may acknowledge and close alarms and add comments and incident reports to any alarm from 
this window. 

This window offers the same alarm features as the Alarms tab (see 16.4 - Alarms Tab). The Alarms 
view described in this section shows alarms for a single device, rather than for all devices.

To view this data:

• Click on the Navigate tab, then click on a device in the tree at left. 
• In the right side of the window, click on the Alarms tab to display alarm history data for the 

selected device in the Viewer Display Area. The alarm list shows details about the time of 
occurrence, type of alarm, source of the alarm, its severity and any comments or incidents. (If an 
alarm was received during a scheduled maintenance and a Reason was specified, that text 
appears in the Incident column.)

• Click on an alarm in the list, then click on these tabs above the list for additional options, which 
are available to users with permission to manage alarms (see 13.2 - Assigning Users to 
Groups):

• Acknowledge - to acknowledge the selected alarm.
• Close - to remove the selected alarm from the display.
• Details - to view or add comments, incident reports and other alarm information in the Alarm 

Details window (see 16.4 - Alarms Tab for more information).
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16.3.4 Navigate - Trends View

Data logging requires a license with Advanced Communications (see Table 12). This feature requires 
logged data via Data Logging or the Read Data action (see 9.2.7 - Data Logging and 12.2.6 - 
Configure Read Data Actions).

The Trends function in the Navigate tab displays a graph of data points for a selected device. The 
data points must be selected for logging and graphing before the graph may be viewed.

To select and view this data:

• Click on the Navigate tab (below left), then click on a device in the tree (left side of the window).
• In the right side of the window, click on the Trends tab.

• Click the Refresh button—either above the graph or at the bottom of the window—to update the 
graph. The graph is not updated with new data until the Refresh button is clicked.

• Click the Setup button above the graph to open the Trend Data Selection window, shown above 
right. See 9.2.7 - Data Logging for details on the Device Data Logging window, a similar 
window—minus the Graph column—where points may be selected for logging.

• Place a check mark  in the Graph column to select a data point (up to eight) to be graphed. 
This also places a check mark in the Log column, indicating the parameter will be logged.

• In the Sampling Interval (minutes) box, choose the time interval for sampling all selected 
data points. The default is 30 minutes; valid entries are from 1 to 10080 minutes (7 days).

• Click OK when finished. Click Refresh to update the graph in the Navigate window.
• Click the Copy data button above the graph to create a comma-delimited copy of the data labels 

and values on the clipboard, which can be pasted into a text or spreadsheet file.
• To change the time axis, place a check mark  in the Show time range selection box below the 

graph. Specify the Duration using either of these options, then click Refresh:
• Previous: Choose the amount of data history to display—e.g., the past 2 hours or 30 days.
• Period: Specify a range of start and end times in the From and To boxes.

• Click-and-drag to draw a rectangular area to zoom in on any portion of the graph. 
• Use the mouse wheel to pan the graph.
• Right-click anywhere on the graph area for a pop-up menu with these additional options:

Menu option Description

Copy or print
the graph 
image

Copy Copy the graph to the clipboard

Page Setup... Change settings for printing the graph

Print... Send the graph to a printer

Display data Show Point Values Display the point values on mouseover

Restore 
original 
view

Un-Zoom Restore original view after zooming

Undo All Zoom/Pan Restore original view after zooming or panning

Set Scale to Default Undo any changes to the graph scale

Save graph image Save Image As... Save the graph as a graphic file

Copy values Copy data Copy data labels and values to the clipboard
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16.3.5 Navigate - Info Links View

The Info Links tab displays information links for a selected device. These include both clickable links 
to Web pages gathered during Auto Discovery of devices and user-defined links to Web page or files 
that pertain to this device.

To view this data:

• Click on the Navigate tab, then click on a device in the tree at left. 
• In the right side of the window, click on the Info Links tab to display configured links for the 

selected device in the Viewer Display Area.

• Permanent info links are gathered automatically during device configuration; they may not be 
edited or deleted.

• User-defined info links are configured by users. For details on adding, editing or deleting these 
links, refer to:

• 9.2.5 - Info Links for details on adding or changing an info link
• 10.2 - Add or Edit an Area to add an info link for an area
• 10.4.1 - Group Properties - Logical Groups to add an info link for a logical group
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16.4 Alarms Tab

The Alarms tab displays alarm history data for all managed devices in the current view. Authorized 
users may acknowledge and close alarms and add comments and incident reports to any alarm.

This window offers the same alarm features as the Alarms view in the Navigate tab (see 16.3.3 - 
Navigate - Alarms View). The Alarms tab described in this section shows alarms for all devices, 
rather than for a single device.

The arrow tab indicates that double-clicking opens the Alarms view in a separate window, which 
can be dragged anywhere on the screen or to another monitor. The Alarms tab disappears from the 
original window as long as the separate window remains open.
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16.4.1 Viewing Alarms

To view this data:

• Click on the Alarms tab to display alarm history data for all devices in the Viewer Display Area.

• The Viewer Display Area displays history data for each alarm (see 16.4.2 - Managing Alarms): 
• Received: the time the alarm was detected by the Nform server
• Alarm: the type of alarm—e.g., Utility failure -- Cleared
• Source: the source of the alarm—e.g., the Nform application (Nform) or a device (Device12)
• Severity: the alarm’s level of severity (see Table 9)
• Comment: an icon indicating comments added in the Alarm Details window
• Incident: a name indicating a related incident added in the Alarm Details window:

• Double-clicking on a device name—e.g., Device12—opens the Navigate tab view of that device. 
Double-clicking on any other part of an alarm listing opens the Alarm Details window (see 
16.4.2 - Managing Alarms).

• To sort the list, click on any heading—for example, Alarm or Source.
• Color-coded numbers of acknowledged and unacknowledged alarms appear above the Detail area.
• For a device in Maintenance mode (see 9.3 - Configure Maintenance Mode): 

Any alarm received while a device is in Maintenance mode has a Maintenance icon in the Severity 
column. If a Reason was entered for a scheduled maintenance, the reason appears in the Incident 
column. Informational alarms indicate when the device enters and returns from Maintenance 
mode, as shown in the following example. 

Received Alarm Source Severity Comment Incident

2008-12-16 09:53:24 Utility failure -- Cleared Device12 Critical

2008-12-16 09:58:55 Service started Nform Informational IncidentA
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16.4.2 Managing Alarms

To manage alarms:

• Start the Viewer with permission to manage alarms (see 13.2 - Assigning Users to Groups)
• Click on the Alarms tab to display alarm history data for all devices in the Viewer Display Area.
• Use standard shift-click and control-click methods to select multiple alarms.
• Select one or more alarms in the list, then click on these buttons to manage alarms:

• Acknowledge - to acknowledge the selected alarm
• Close - to remove the selected alarm from the display

• To view or add details for alarms, select one or more alarms in the list, then click on the Details 
button to open the Alarm Details window, shown below right.

• The Alarm Information at the top is for display only: the alarm name, description and other 
details such as severity level and time received. 

• The Alarm Action Details shows a list of actions executed as a result of this alarm.
• The Display Graph button is enabled only if a Read Data action—mapped to this alarm for 

this device—is selected in the Alarm Action Details list. When enabled, this button displays a 
trend graph (see 16.3.4 - Navigate - Trends View).

• In the Alarm Status area, place a check mark  in the Acknowledge or Close box as needed.
• In the Incident box, enter a description (up to 20 characters)—for example, an event that may 

have caused the alarm. This description is displayed in the Alarms view.
• Enter any additional notes in the Comments box. An icon appears in the Alarms view after a 

comment is added to an alarm.
• When finished, click OK to save changes (or Cancel to close the dialog without saving).
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16.4.3 Informational Icons in the Navigation Tree
The Navigation tree displays icons to indicate normal operation, active alarms, communication loss 
and other conditions of managed devices and floor plans. The Alarms view displays icons to indicate 
the severity level.

Table 9 summarizes the meaning of icons that indicate the status of monitored and managed devices.

Table 9 Informational icons - summary

Icon Description Additional information

DEVICE ICONS

Battery monitoring device —

I/O device —

Power device —

Precision cooling device —

Rack PDU device —

UPS device —

Other device —

STATUS ICONS (examples with UPS device)

Device in normal status —

Device not being monitored for status —

Active alarm received from this device —

Device in maintenance mode
Appears for a device in maintenance mode above any 
status icon—e.g., Active alarm or No communication. 

No communication with this device When this “no communication” symbol appears, verify 
that your network cables are connected. 
If further action is required, consult your SNMP card 
user manual.

No communication with at least one 
device in this area

ALARM ICONS

Critical alarm —

Warning alarm —

Informational alarm —

Maintenance mode See 9.3 - Configure Maintenance Mode.

NAVIGATION TREE ALARMS VIEW

Alarm Icons

Device
icons

Status
icons
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17.0 RUNNING LIEBERT NFORM

After installation, the Liebert Nform service begins running in the background, monitoring and 
managing all configured devices. 

The Liebert Nform service continues running constantly, but it may be stopped and restarted through 
the following methods:

Method For details, see:

• The Windows Services application allows you to stop the 
Liebert Nform service manually. 

17.1.3 - Stop the 
Liebert Nform Service

• The same Services application allows you to resume the 
Liebert Nform service without having to restart the computer.

17.1.4 - Restart the 
Liebert Nform Service

• The service is stopped automatically during operations 
performed in the Tools application. 

18.0 - Using Nform 
Tools

• After being stopped automatically, the service restarts 
automatically when exiting the Tools application.

18.3.2 - Application 
Menu - Close Nform 
Tools

NOTE
Stopping the service prevents Liebert Nform from monitoring and managing your devices.
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17.1 Starting or Stopping the Liebert Nform Service
Under normal circumstances, you will not need to start or stop the Liebert Nform service manually. 
This may be done in the Nform Tools application (see 18.3.1 - Application Menu - Service) or from 
the Windows Services application, as described below.

17.1.1 Open the Services Application

1. Click on the Start button, then Control Panel.
2. In the Control Panel window:

• (Windows 7 and Server 2008 R2) Click on System and Security. 
• (Windows Vista and Server 2008) Click on System and Maintenance. 
• (Windows XP and Server 2003) Click on Performance and Maintenance. 

3. Click on Administrative Tools. 
4. Double-click on Services.

• (Windows Vista & Server 2008) Click on Continue in the User Account Control window.
5. Perform the following functions as needed.

17.1.2 Verify Whether the Liebert Nform Service is Running (Status column)

• Check the Status column in the Services window to see whether the Liebert Nform service is 
running (Started) or not running (blank).

17.1.3 Stop the Liebert Nform Service

This action prevents Liebert Nform from monitoring and managing your devices. To stop the service:

• Right-click on Liebert Nform, then click on Stop in the pop-up menu. 
(Or click on Liebert Nform, then on the Action menu at the top of the window, then Stop.)

17.1.4 Restart the Liebert Nform Service

The service starts automatically when the monitoring workstation is restarted. To start it manually:

• Right-click on Liebert Nform, then click on Restart in the pop-up menu. 
(Or click on Liebert Nform, then on the Action menu at the top of the window, then Restart.)

Examples shown for Windows XP
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18.0 USING NFORM TOOLS

This section describes the following options available in the Nform Tools application:

• Stop, start or restart the Nform service
• Change database connection options for an SQL Server database
• Switch from one type of database—bundled or SQL Server—to another
• Perform database maintenance operations on a bundled database: verify and repair, shrink and 

compact, upgrade from an older version (rarely needed)
• Install device definitions (DTDs) to expand Nform support for additional devices
• Import Liebert Nform version 2.X data from one server into version 4.X on a different server
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18.1 Open the Nform Tools Application From the Start Button

Nform Tools may be opened from the Start button as described in this section or from the Nform 
Viewer (see 5.1 - Nform Tools).

To open the application from the Start button:

• Click on the Start button, then on Programs, Liebert Nform and finally Nform Tools. 
• (Windows Vista, Server 2008 and later) A User Account Control (UAC) message appears, 

requesting your permission to start the application. Click Allow to continue.
• The Liebert Nform Tools window opens, shown below.

• Menus at the top of the window—Application, Database and Tools—are described in the 
following sections:

• 18.2 - Menus in Nform Tools
• 18.3 - Application Menu
• 18.4 - Database Menu
• 18.5 - Tools Menu

• The status of the Nform service appears at bottom left: Running or Stopped.
Some operations in the Nform Tools application require stopping the Liebert Nform service, so it 
is stopped automatically when needed. If the service is stopped for this or any reason, it restarts 
automatically when the Nform Tools application is closed.

Status of 
Nform 
service

Menus

Windows XP Windows Vista, Server 2008 & later - User Account Control (UAC) message
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18.2 Menus in Nform Tools

Menus at the top of the Liebert Nform Tools window include: Application, Database and Tools. 
Each menu has a drop-down list of options, as shown in Table 10.

Table 10 Nform Tools menu options - summary

Menu Option Function For more details, see:

Application Service Start, stop or restart the Liebert Nform service.
18.3.1 - Application Menu - 

Service

Exit
Close the Tools application. 
(If the Liebert Nform service is stopped, it restarts 
automatically when the application is closed.)

18.3.2 - Application Menu - 
Close Nform Tools

Database

Connection
Make changes to database connection options or 
specify a different type of database after 
installation (Step 5 in 2.1 - Installation).

18.4.1 - Database - Connection

Verify*
Check the integrity of an Nform database. If a 
database fails the test, use the Repair option to 
try to fix it.

18.4.2 - Database - Verify

Repair*
Attempt to fix a corrupted Nform database—for 
example, if a database fails the Verify test.

18.4.3 - Database - Repair

Shrink*
Reduce database size by moving free space, 
then truncating the file (less thorough but quicker 
than the Compact option).

18.4.4 - Database - Shrink

Compact*
Reduce database size by creating a new file from 
the existing database file (more thorough but 
takes longer than the Shrink option).

18.4.5 - Database - Compact

Upgrade*

(Not needed in most cases) 
Use this option for manually upgrading Nform 4.0
embedded databases (SQL CE** 3.1) to the
current Nform 4.1 (SQL CE 3.5) format.

18.4.6 - Database - Upgrade

Tools
Install DTD

Install Device Type Definitions for new equipment
from a package file available from Emerson.

18.5.1 - Tools Menu - Install 
DTD

Tools
Import Liebert Nform version 2.X data from one 
server into version 4.1 on a different server.

18.5.2 - Tools Menu - Import 2.5 
Data

* These Database menu options apply only to bundled databases (see Step 5 of 2.1 - Installation), not SQL Server databases.
** SQL CE = Microsoft SQL Server Compact Edition
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18.3 Application Menu

This menu has options for:

• Start, stop or restart the Liebert Nform service (18.3.1 - Application Menu - Service) 
• Exiting the Tools application (18.3.2 - Application Menu - Close Nform Tools)

18.3.1 Application Menu - Service

This menu item allows you to stop, start or restart the Liebert Nform service. To do this:

• Log into Windows on the Nform server as a user with administrator privileges on that machine.
• Click on the Application menu in the Liebert Nform Tools window, then on Service.

• The Service Control window displays the status of the Nform service—Running or Stopped—and 
has buttons to Stop, Start or Restart the Nform service. 

• A progress bar appears after you click a button to stop, start or restart the Nform service. When 
the process is complete, the new status appears in the Nform Service Status box.

• If the Nform Viewer is open when the service is stopped, a message alert indicates the loss of 
communication, along with a reminder to restart the service and log in again.

Stopping Nform service

Progress bar

Loss of communication notice if Nform Viewer is open
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18.3.2 Application Menu - Close Nform Tools

Some Nform Tools operations cannot be performed with the Liebert Nform service running, so the 
service is stopped automatically. If the service is stopped, it restarts automatically when the Tools 
application is closed as described in this section.

For more details on the Liebert Nform service and other ways to start or stop the service, see 17.0 - 
Running Liebert Nform and 18.3.1 - Application Menu - Service.

To close the Nform Tools application:

• Click on the Application menu in the Liebert Nform Tools window, then on Exit.

• If the Liebert Nform service is stopped, a Service Control window displays a message that the 
service is restarting. If this message appears, click OK to close the window.

Status of 
Nform 
service

Exit



Using Nform Tools

Liebert® Nform™ 131

18.4 Database Menu

This menu has options for:

• Making changes to database connection options (18.4.1 - Database - Connection) 
• Database maintenance tasks for a bundled database (Sections 18.4.2 - 18.4.6)

18.4.1 Database - Connection

The Connection option is designed to allow changes to database connection options after installation.

To make changes to database connection options:

• Click on the Database menu in the Liebert Nform Tools window, then on Connection.

• To switch to a different type of database, click on the type of database at the top of the window, 
then click OK.

• To make changes to connection options, click on the type of database at the top of the window, 
make the following changes as needed, then click OK when finished.

• The Data Source box displays the connection source using the format Server\Instance:

• The Primary Database Name box displays the name of the database—for example, Nform. 
This name is used for the database, alarm file (Nform.alm) and data log file (Nform.log).

• If needed, enter a login user name in the User Name box.
• If needed, enter a login password in the Password box, then enter the same password in the 

Confirm Password box.

Server
The hostname or IP address of the connection server. To specify the same computer as the 
database server, enter (local)—for example:

Server01 OR 192.168.1.32 OR (local)

Instance
(Optional)

A named instance of the SQL Server database engine if multiple instances are running 
concurrently on the same computer—for example:

Server01\Instance05 OR 192.168.1.32\Instance05 OR (local)\Instance05
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18.4.2 Database - Verify

Use this option to check the integrity of an Nform database. If a database fails the test, use the 
Repair option to try to fix it (see 18.4.3 - Database - Repair). This applies to bundled databases 
only (2.1 - Installation). The option is disabled if there is no connection to the Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.

To verify databases:

• Click on the Database menu in the Liebert Nform Tools window, then on Verify.
• In the Embedded Database Operation window, click to place a mark  to the left of each type of 

database to verify: Primary database, Alarms database, Data log database.
• When ready to proceed, click the Verify button. The Nform service will be stopped, indicated by 

the status in the bottom left corner of the Tools window.
• When the operation is complete, the result—Success or Fail—appears to the right of each 

selected database. If a Fail message appears, proceed to 18.4.3 - Database - Repair. If the 
condition cannot be corrected with a repair operation, contact Emerson Technical Support.

• Click Close to return to the Liebert Nform Tools window.

Status of 
Nform 
service
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18.4.3 Database - Repair

Use this option to attempt to fix a corrupted Nform database—for example, if a database fails the 
Verify test (see 18.4.2 - Database - Verify). This applies to bundled databases only (2.1 - 
Installation). The option is disabled if there is no connection to the Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.

To repair databases:

• Click on the Database menu in the Liebert Nform Tools window, then on Repair.
• In the Embedded Database Operation window, click to place a mark  to the left of each type of 

database to repair: Primary database, Alarms database, Data log database.
• When ready to proceed, click the Repair button. The Nform service will be stopped, indicated by 

the status in the bottom left corner of the Tools window.
• When the operation is complete, the result—Complete or Fail—appears to the right of each 

selected database. If a Fail message appears, contact Emerson Technical Support.
• Click Close to return to the Liebert Nform Tools window.

Status of 
Nform 
service



Using Nform Tools

Liebert® Nform™ 134

18.4.4 Database - Shrink

Use this option to reduce database size by moving free space, then truncating the file. This is less 
thorough but quicker than the Compact option (18.4.5 - Database - Compact). This applies to 
bundled databases only (2.1 - Installation). The option is disabled if there is no connection to the 
Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.

To shrink databases:

• Click on the Database menu in the Liebert Nform Tools window, then on Shrink.
• In the Embedded Database Operation window, click to place a mark  to the left of each type of 

database to shrink: Primary database, Alarms database, Data log database.
• When ready to proceed, click the Shrink button. The Nform service will be stopped, indicated by 

the status in the bottom left corner of the Tools window.
• When the operation is complete, the result—Complete or Fail—appears to the right of each 

selected database. If a Fail message appears, contact Emerson Technical Support.
• Click Close to return to the Liebert Nform Tools window.

Status of 
Nform 
service
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18.4.5 Database - Compact

Use this option to reduce database size by creating a new file from the existing database file. This is 
more thorough but takes longer than the Shrink option (18.4.4 - Database - Shrink). This applies to 
bundled databases only (2.1 - Installation). The option is disabled if there is no connection to the 
Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.

To compact databases:

• Click on the Database menu in the Liebert Nform Tools window, then on Compact.
• In the Embedded Database Operation window, click to place a mark  to the left of each type of 

database to compact: Primary database, Alarms database, Data log database.
• When ready to proceed, click the Compact button. The Nform service will be stopped, indicated 

by the status in the bottom left corner of the Tools window.
• When the operation is complete, the result—Complete or Fail—appears to the right of each 

selected database. If a Fail message appears, the original database will have been renamed as 
*.bak (e.g., NformLog.sdf.bak) and will be unchanged. Rename the database with its original 
name (e.g., NformLog.sdf), then restart the service to resume operation as before.

• Click Close to return to the Liebert Nform Tools window.

Status of 
Nform 
service
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18.4.6 Database - Upgrade

This option is not needed in most cases. Use this option for manually upgrading Nform 4.0 embedded 
databases (SQL CE 3.1) to the current Nform 4.1 (SQL CE 3.5) format (SQL CE = Microsoft SQL 
Server Compact Edition). This applies to bundled databases only (2.1 - Installation). The option is 
disabled if there is no connection to the Nform database.

Initiating this process automatically stops the Liebert Nform service if it is running.

To upgrade databases:

• Click on the Database menu in the Liebert Nform Tools window, then on Upgrade.
• In the Embedded Database Operation window, click to place a mark  to the left of each type of 

database to upgrade: Primary database, Alarms database, Data log database.
• When ready to proceed, click the Upgrade button. The Nform service will be stopped, indicated 

by the status in the bottom left corner of the Tools window.
• When the operation is complete, the result—Success or Fail—appears to the right of each 

selected database. If a Fail message appears, contact Emerson Technical Support.
• Click Close to return to the Liebert Nform Tools window.

Status of 
Nform 
service
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18.5 Tools Menu
This menu has options for:

• Downloading and installing Device Type Definition (DTD) files to expand Liebert Nform support 
for additional devices (18.5.1 - Tools Menu - Install DTD) 

• Importing Liebert Nform version 2.X data from one server into version 4.X on a different server 
(18.5.2 - Tools Menu - Import 2.5 Data)

18.5.1 Tools Menu - Install DTD

A Device Type Definition (DTD) package is a set of files that identify additional devices for Liebert 
Nform to monitor and manage, besides the many device definitions installed with Liebert Nform. 

DTD packages for new equipment may be obtained from Emerson Network Power and may include 
devices made by Emerson as well as other manufacturers.

A DTD package is provided as a set of files that must be installed on the Liebert Nform server before 
this type of device may be added to the managed device list. 

To download and install a DTD on the Liebert Nform server:

• On the Nform server, click on the Tools menu in the Liebert Nform Tools window, then on 
Install DTD. This opens the Install Device Type Definitions (DTD) window.

• The Install Device Type Definitions (DTD) window has two sections, one for downloading a DTD 
package and the other for installing the package on the Nform server:

Download Package
• To download the file from the Liebert Web site, enter the URL in the Download Package box, 

then click the Download button. After downloading, continue to the next step to install.

Install Package
• After obtaining a DTD package file, enter the full path to that file in the Install Package text 

box or click on the Browse button to locate the file.
• Click the OK button to install the DTD. 

When finished, you may add any new device types to the configuration in the Nform Viewer (see 9.1 - 
Add Devices to the Configuration). 

Download 
from Web

Install
on Nform 
server
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18.5.2 Tools Menu - Import 2.5 Data

This feature may be used to import Liebert Nform version 2.X data from one server into version 4.X 
on a different server.

To prepare for the import, see 2.4.3 - Import Exported Data from a Different Server for details 
on these steps:

• Install Liebert Nform 4.X.
• Create a temporary folder on the 4.X server, then copy the exported files from the 2.X server.
• Open Nform Tools on the 4.X server (see 18.1 - Open the Nform Tools Application From the 

Start Button).

To import the data:

• Click on the Tools menu in the Liebert Nform Tools window, then on Import 2.5 Data.
• In the Directory box, enter the full path or click the Browse button to locate the folder 

containing the exported files, then click Open.

• Click Import. The import utility will stop the Nform service, import the appropriate files and 
restart the service. A message confirms the process is complete.

• When finished, close the Nform Tools application by clicking on the Application menu, then on 
Exit (see 18.3.2 - Application Menu - Close Nform Tools).

Import



Uninstalling Liebert Nform / Removing License Keys

Liebert® Nform™ 139

19.0 UNINSTALLING LIEBERT NFORM / REMOVING LICENSE KEYS

This section describes how to remove the Liebert Nform application and how to delete a license key.

19.1 Uninstalling Liebert Nform

To remove Liebert Nform from your computer, run the Windows Add/Remove Programs, which is 
found in the control panel.

1. Open the Control Panel: Click on the Start button, then Settings, and finally Control Panel.

2. In the Control Panel window, above left, double-click on Add or Remove Programs 
(in Windows Vista, double-click on Programs and Features).

3. In the list of installed programs, above right, double-click on Liebert Nform.

4. In the Application Maintenance window, above left, click Remove to uninstall the software.
5. In the Liebert Nform Uninstall window, above right, choose one of these options:

• Remove complete application to remove the Liebert Nform software, as well as device and 
alarm data and all related files.

• Remove application programs only to remove the software only, keeping device and 
alarm data and related files.

6. Click Remove.
7. When the process is complete, a window appears, as shown above. Click Finish to exit.
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19.2 Deleting a License Key

If more than one license key is installed, there may be a need to remove a secondary license key—for 
example, to move it to another computer to monitor a different group of devices. 

To remove a license key:

1. Start the Viewer with permission to manage licenses (see 13.2 - Assigning Users to Groups).
2. Click on the Configure Licenses icon at the bottom of the window (or click on the Configure 

menu, then choose Licenses).

3. In the Licenses window, click on the license key to be removed, then click the Delete button.
4. A confirmation window asks whether to continue with the deletion. Click Yes to delete the license 

key (or No to cancel without deleting it).
If the license to be deleted is the only license, an alert window displays a message that the last 
managed device license cannot be deleted (shown above right).

! WARNING
Liebert Nform does NOT prevent users from deleting the base license, even if doing so would 
reduce the authorized number of devices below the number of configured devices.
Deleting the base license would prevent remote user login, data trending and trap forwarding 
to a remote management center.

NOTE
The initial license key permits a certain number of devices and unlimited remote users.

Supplemental license keys allow for 30, 100 or 500 additional devices. Contact your local 
Emerson representative or see Appendix C - Ordering Parts and Licenses From Emerson 
Network Power for details.

At least one license key containing a device license must be installed to manage the network.

Any number of users can log into the local host.

You will not be able to log in remotely if the base license is removed.

Liebert Nform prevents users from deleting a license if:

• the deletion would reduce the number of allowed remote users to fewer than the number of 
logged-in remote users.

• the deletion would reduce the number of allowed devices to fewer than the number of 
configured devices.

If a license is inadvertently deleted, Liebert Nform allows the user to reinstall it (see 4.4 - 
Enter the License Key).

!

Configure 
Licenses

If only 1 license is installed
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20.0 LIEBERT SOFTWARE PROGRAM LICENSE AGREEMENT

This section contains the license agreement for Liebert Nform.

LIEBERT NFORM™ SOFTWARE LICENSE AGREEMENT

READ THESE TERMS AND CONDITIONS CAREFULLY BEFORE ATTEMPTING TO
DOWNLOAD, INSTALL, OR USE THE SOFTWARE. BY DOWNLOADING, INSTALLING, OR
USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THESE TERMS AND
CONDITIONS. IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS, DO NOT
DOWNLOAD, INSTALL, OR USE THE SOFTWARE.  IN SUCH A CIRCUMSTANCE, THE
SOFTWARE MAY BE RETURNED WITHIN THIRTY (30) DAYS OF YOUR RECEIPT FOR A
FULL SOFTWARE REFUND. YOU REPRESENT THAT YOU (I) ARE NOT LOCATED IN,
UNDER THE CONTROL OF, OR A NATIONAL RESIDENT OF ANY COUNTRY TO WHICH
THE UNITED STATES HAS EMBARGOED GOODS, (II) ARE NOT ON THE U.S. TREASURY
DEPARTMENT'S LIST OF SPECIALLY DESIGNATED NATIONALS, (III) ARE NOT ON THE
U.S. COMMERCE DEPARTMENT'S LIST OF DENIED PERSONS, OR (IV) ARE NOT
OTHERWISE PROHIBITED BY U.S. LAW FROM RECEIVING OR USING THE SOFTWARE
(COLLECTIVELY "EXPORT RESTRICTIONS"). IF YOU DO NOT HAVE AUTHORITY TO
ACCEPT THIS AGREEMENT FOR YOUR ORGANIZATION, IT IS YOUR OBLIGATION TO
ENSURE THAT AN AUTHORIZED INDIVIDUAL MAKES THE DETERMINATION THAT
YOUR ORGANIZATION IS NOT SUBJECT TO THE ABOVE EXPORT RESTRICTIONS
PRIOR TO DOWNLOADING, INSTALLING, OR USING THE SOFTWARE.

This Nform Software License Agreement ("Agreement") is a legal agreement between you and Liebert 
Corporation, an Ohio, United States of America, corporation, ("Liebert").  Liebert's Nform software, 
including enhancements, upgrades, and any future releases, if provided, is made available exclusively 
for use with Liebert products and/or non-Liebert products provided that you obtain the appropriate 
product template from Liebert for non-Liebert products (individually and collectively, "Products"). The 
foregoing, including any accompanying program(s), documentation, images, animation, and text 
incorporated therein, (collectively "Software"), is provided solely for commercial and industrial use 
under the license terms specified herein. 

GRANT OF RIGHTS:  Provided that you comply with all of the terms of this Agreement, Liebert 
grants a non-exclusive, non-transferable license to you to install and use the Software solely for use 
with Products as provided for herein. You represent and warrant that you will not use the Software in 
violation of applicable laws and regulations or where such use detrimentally affects Liebert's rights in 
the Software or subjects Liebert to liability.  You assume responsibility for the selection of the Software 
to achieve your intended results, and for the installation, use, and the results obtained from the 
Software. Provided that you have paid the applicable license fees, you may use the Software in 
accordance with the license indicated on your Order Acknowledgement.  Any other operation of the 
Software at any time shall constitute a material breach of this Agreement and shall terminate this 
license as provided for below.  By use of the Software, you agree that Liebert may, at its option, perform 
an audit of your usage of the Software to determine the number of servers and Products that are using 
the Software.

TERMINATION OF LICENSE:  Your license is automatically terminated if you: (1) use the Software 
with anything other than Products, (2) attempt to copy or reconstruct any part of the object code, source 
code, or algorithms, (3) attempt to decompile, disassemble or reverse engineer the Software, in whole or 
in part, or otherwise attempt to derive the source code of the Software, (4) provide, disclose, sell, rent, 
lease, license, sublicense, or otherwise transfer or assign the Software to any third party, (5) use the 
Software in excess of the licensed coverage purchased, (6) write or develop any derivative software or 
any other software program based upon the Software, (7) modify or alter the Software, or (8) fail to 
comply with any other license terms.  You may elect to terminate this license at any time by destroying 
the Software together with all copies and any portions thereof in any form.

(continued)
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LIMITED WARRANTY:  Liebert represents that it has the right and authority to grant the license 
herein.  Liebert warrants solely to you for a period of thirty (30) days from the date of Liebert shipment 
or distribution that the distribution media (if supplied) on which the Software is furnished under 
normal use will be free from defects in material and workmanship and the Software will substantially 
conform to Liebert published documentation. EXCEPT FOR THE ABOVE EXPRESS WARRANTIES, 
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING, WITHOUT LIMITATION, IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR INTENDED PURPOSE.  LIEBERT DOES NOT WARRANT 
THAT THE SOFTWARE FUNCTIONS WILL MEET YOUR REQUIREMENTS OR THAT THE 
SOFTWARE WILL OPERATE UNINTERRUPTED OR ERROR FREE.

LIMITATION OF REMEDIES: Liebert's entire liability and your exclusive remedy arising from use 
or inability to use the Software is:(1) The replacement of any distribution media not meeting Liebert's 
warranty, or (2) If Liebert is unable to provide you a replacement that conforms to Liebert's warranty, 
to refund the purchase price. THE REMEDIES SET FORTH IN THIS AGREEMENT ARE 
EXCLUSIVE.  

LIMITATION OF DAMAGES:  IN NO EVENT, REGARDLESS OF THE FORM OF THE CLAIM 
OR CAUSE OF ACTION (WHETHER BASED IN CONTRACT, INFRINGEMENT, 
NEGLIGENCE, STRICT LIABILITY, OTHER TORT, OR OTHERWISE), SHALL LIEBERT'S 
LIABILITY TO YOU EXCEED THE PRICE PAID BY YOU FOR THE SOFTWARE.  YOU 
AGREE THAT LIEBERT'S LIABILITY TO YOU SHALL NOT EXTEND TO INCLUDE 
SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES EVEN IF LIEBERT 
IS ADVISED OF THE POSSIBILITY OF THESE DAMAGES.  The term "consequential damages" 
shall include, but not be limited to, loss of anticipated profits, business interruption, loss of use, 
revenue, reputation and data, costs incurred, including without limitation, for capital, fuel, power and 
loss or damage to property or equipment.  You acknowledge that this Agreement reflects this allocation 
of risk.  

COPYRIGHT:  This Software is the proprietary property of Liebert and/or its suppliers and is 
protected by United States copyright laws, other applicable copyright laws, and international treaty 
provisions.  Title and ownership of all copyrights to the Software remain in Liebert or third parties.  
Accordingly, your rights to use, copy and modify the Software are strictly limited to the specific rights 
provided in this Agreement or as may otherwise be required by applicable copyright law.

U.S. GOVERNMENT RESTRICTED RIGHTS:  This Software is developed at private expense and is 
provided with "Restricted Rights."  Use, duplication, or disclosure by the United States Government is 
subject to restrictions set forth in the Federal Acquisition Regulations and its Supplements. 

ASSIGNMENT:  You may not sublicense, assign, or otherwise transfer this license of the Software 
without the prior written consent of Liebert.  Any such transfer of rights, duties, or obligations is void 
and terminates this Agreement.

EXPORT RESTRICTIONS:  You may not export the Software in violation of applicable export laws 
and regulations of the applicable countries.  You agree to comply with all laws, regulations, decrees and 
orders of the United States of America that restrict the exportation (or re-exportation) of the Software 
to other countries, including, without limitation, the U.S. Export Administration Regulations.

UPDATE POLICY:  Liebert may create, from time to time, updated versions of the Software.  Liebert 
reserves the right to make changes to or improvements in any aspect of the Software at any time 
without prior notice to you and without an obligation to supply such changed and/or improved Software 
to you.

NUCLEAR/MEDICAL:  THE SOFTWARE IS NOT FOR USE IN CONNECTION WITH ANY 
NUCLEAR, MEDICAL, LIFE-SUPPORT, AND RELATED APPLICATIONS.  You agree to defend, 
indemnify, and hold harmless Liebert from any claims, losses, suits, judgments and damages, including 
incidental and consequential damages, arising from such use, whether the cause of action be based in 
tort, contract or otherwise, including allegations that the Liebert's liability is based on negligence or 
strict liability.

(continued)
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JAVA SUPPORT:  The Software may contain support for programs written in Java. Java Technology 
is not fault tolerant and is not designed, manufactured, or intended for use or resale as online control 
equipment in hazardous environments requiring fail-safe performance, such as in the operation of 
nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support 
machines, or weapons systems, in which the failure of java technology could lead directly to death, 
personal injury, or severe physical or environmental damage.

COMPLETE AGREEMENT/GOVERNING LAW/VENUE:  This Software license agreement 
comprises the final and complete agreement between the parties. No person is authorized to change or 
modify this Agreement except an executive officer of Liebert Corporation and then only in writing.  The 
laws of the United States and the State of Ohio shall apply to this Agreement and its interpretation 
without reference to choice or conflict of laws principles.  Liebert and you hereby irrevocably submit to 
the personal and subject matter jurisdiction of any State of Ohio or federal court sitting in Columbus, 
Ohio, in any action or proceeding arising from or relating to this Agreement.  If any provision of this 
Agreement is held to be void, invalid, unenforceable, or illegal, the other provisions shall continue in 
full force and effect.

Liebert Nform Software License revision June 28, 2008

LIEBERT NFORM™ SOFTWARE LICENSE AGREEMENT (continued)
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APPENDIX A - TECHNICAL INFORMATION & FREQUENTLY ASKED QUESTIONS

1. What is a DHCP server?
DHCP is the acronym for Dynamic Host Configuration Protocol. This protocol allows hostnames 
to be allocated dynamically when computers are connected to a network. This protocol is often 
used to remotely grant a hostname to a computer for a limited time, as when a student uses a 
computer for a quarter or longer. See RFC-1541 for more detailed information. (RFCs are Request 
For Comment documents that set forth regulations on how communication occurs on the Internet. 
These documents are controlled by the Internet Engineering Task Force (IETF) and are available 
for viewing at the IETF Web site.)

2. How do I identify possible TCP/IP port conflicts when using a UPS equipped with an 
SNMP card? How do I resolve the conflict?
TCP/IP port conflicts with port 162 can be resolved by stopping the SNMP trap service from 
running. This product does not support running on the same machine as a Network Management 
System (NMS).
For the proper procedure to stop the SNMP services, see 17.0 - Running Liebert Nform.

3. What is a service?
A service is a process initiated at boot time that requires no user intervention to start and run. A 
service continues to run after the user logs off the computer.
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APPENDIX B - DATA MONITORED BY LIEBERT NFORM

Liebert supplies a template for each SNMP device, containing data points and alarms applicable to 
that device. The names of data points and alarms can be changed (see 10.0 - Configuring Views for 
the Navigate Tab).

• Data points are the information Liebert Nform compiles from polling a managed SNMP device. 
• Alarms are out-of-tolerance conditions that Liebert Nform reports to users. 

Table 11 below show sample data points and alarms for environmental and UPS units with SNMP 
cards.

B.1 SAMPLE DATA POINTS AND ALARMS

The following table shows examples of data points and alarms for a precision cooling unit.

Table 11 Sample data points and alarms - Precision cooling unit

Data points Alarms

Agent lost device 
communication

High temperature

Low temperature

High humidity

Low humidity

Change filter

High head pressure 1

High head pressure 2

Water under floor

Low water in humidifier

Lost power

Local alarm 1

Local alarm 2

Compressor 1 low pressure

Compressor 2 low pressure

Faulty sensor detected

Service cooling

Service humidifier

System control battery low

Agent firmware corrupt

Conditions present
Statistics run hours
Agent manufacturer
Agent model
Agent firmware version
Agent serial number
Agent reboot
Temperature setting
Temperature setting
Humidity setting
System state
Humidifying state
Dehumidifying state
Fan state
General alarm output state
Cooling capacity state
Heating capacity state
Audible alarm state
Cooling unit 1's state
Cooling unit 2's state
Heating unit 1's state
Heating unit 2's state
Configure restart delay
Configure remote shutdown
Configure cooling service interval
Configure humidifier service interval
Configure filter service interval
Control shutdown after delay
Control startup after delay
Statistics compressor 1 run hour
Statistics compressor 2 run hour
Statistics main fan run hour

Statistics humidifier run hour
Statistics reheat element 1 run hour
Statistics reheat element 2 run hour
Statistics cooling mode hours
Statistics heating mode hours
Statistics humidify mode hours
Statistics dehumidify mode hours
Board battery voltage
Device manufacturer
Device model
Device firmware version
Device unit number
Device serial number
Device manufacture date
Control temperature
Return air temperature
Supply air temperature
Control high temperature alarm setpoint
Return air high temperature alarm setpoint
Control low temperature alarm setpoint
Return air low temperature alarm setpoint
Control temperature
Return air temperature
Supply air temperature
Control high temperature alarm setpoint
Return air high temperature alarm setpoint
Control low temperature alarm setpoint
Return air low temperature alarm setpoint
Control humidity
Return air humidity
Supply air humidity
Humidity high alarm setpoint
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APPENDIX C - ORDERING PARTS AND LICENSES FROM EMERSON NETWORK POWER

The table below lists part numbers for items available from Emerson Network Power. To obtain any item, 
visit the Liebert Web site at http://nform.liebert.com or contact your local Emerson representative, value-
added reseller or distributor.

Table 12 Liebert Nform part and license numbers

Item Part/License Number Description

Liebert Nform Software on CD-ROM NFORM-EXP

Liebert Nform with license key1 for:
• 30 devices, not expandable
• Unlimited users
• Advanced Communications—enables:

• Data Logging function (see Section 9.2.7)
• Read Data action (see Section 12.2.6)

Liebert Nform Software on CD-ROM NFORM-STD

Liebert Nform with license key1 for:
• 30 devices, expandable to 4,800 with additional 

license keys
• Unlimited users
• Advanced Communications—enables:

• Data Logging function (see Section 9.2.7)
• Read Data action (see Section 12.2.6)

Liebert Nform Software on CD-ROM
Liebert MultiLink 1.5 Shutdown
Client Software on CD-ROM

NFORM-ENT

Liebert Nform with license key1 for:
• 100 devices, expandable to 10,000 with additional 

license keys
• Unlimited users
• Advanced Communications—enables:

• Data Logging function (see Section 9.2.7)
• Read Data action (see Section 12.2.6)

• Advanced Notifications—enables:
• Trap Forwarding (see Section 8.7)
• Forward Trap (see Section 12.2.5) 

• Unlimited MultiLink 1.5 Shutdown Clients2

must be installed separately and enables:
• Configure Shutdown menu (see Section 11)
• Shutdown action (see Section 12.2.4)

30 Device License NFORM-30D License key3 for 30 additional devices

100 Device License NFORM-100D License key3 for 100 additional devices

500 Device License NFORM-500D License key3 for 500 additional devices

Liebert Nform Upgrade to Standard 
Edition NFORM-STD-UP License key for upgrading Liebert Nform to the 

Standard Edition

1. See 4.4.1 - Add a Liebert Nform License Key for step-by-step instructions.
2. The shutdown license must be installed in addition to the Liebert Nform license key, as described in 4.4.2 - Add a Liebert 

MultiLink 1.5 Shutdown License.
3. Each additional license key must be installed separately, as described in 4.4.1 - Add a Liebert Nform License Key.

http://nform.liebert.com
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